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Overview 1
• What is CloudLink?
• Deployment Workflow
• Partner Dashboard
• Best Practices for Site Deployments

Welcome to CloudLink! Before you onboard your first customer, see the topics listed below, which will
provide answers to the following questions:

What are the components of the CloudLink platform?

What are the processes required to deploy CloudLink applications for a customer?

What is the Partner Dashboard?

1.1 What is CloudLink?

Mitel CloudLink is a platform that enables communication between the on-premise PBX (such as
MiVoice Office 400) and cloud-based applications such as Mitel One.
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Overview

CloudLink includes:

• CloudLink Platform- The technology platform that provides services for CloudLink
apps.

• CloudLink Gateway-Technology that connects premise-based PBXs to the CloudLink
platform and CloudLink applications.

• CloudLink Apps-The applications that use the CloudLink Application Programming
Interfaces (APIs) and micro-services to provide hybrid communications services to our
customers. For example, Mitel One application.

1.2 Deployment Workflow

The following topics document the most important processes for deploying Mitel CloudLink
applications for your customers:

• Configure MiVoice Office 400 PBX
• Install the CloudLink Gateway Appliance
• Access the CloudLink Gateway
• Onboard Customers

Within the above topics you will find different instructions for the different supported MiVoice
Office PBX models and platforms listed below:

Supported PBX Supported Platforms (type of
 Gateway)

Customer Market

standalone (connects to an
external Gateway)

EuropeMiVO400

SMBC (has an embedded
Gateway)

Europe

Customers will be able to utilize a CloudLink application by doing the following:

• Downloading and installing the CloudLink app
• Registering the CloudLink app

CloudLink Gateway User Guide 2
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1.3 Partner Dashboard

The home page of the CloudLink Gateway Portal, which is also known as the Partner Dashboard,
can be used to do the following:

• Create customers in the CloudLink platform.
• Associate a CloudLink Gateway with a customer.
• Connect a CloudLink Gateway to a PBX.
• View and manage previously created CloudLink customers.

After you create a customer in the CloudLink Platform, that customer is listed in the Partner
Dashboard.

Follow these instructions to log into the CloudLink Gateway Portal.

Welcome to CloudLink

The following image shows an example of the Partner Dashboard the first time a partner logs into
the CloudLink Gateway Portal:

When you log into the CloudLink Gateway Portal via the Mitel MiAccess Portal, your MiAccess
account is created as a customer in the CloudLink Platform.

If you have a CloudLink Gateway and a PBX on your LAN, you can onboard your own MiAccess
account into CloudLink to become familiar with the process. Doing this also enables your account
to use CloudLink applications such as Mitel One.

3 CloudLink Gateway User Guide
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Overview

Note:
Every customer in the CloudLink Platform is assigned a unique identifier known as
the 'Account ID'.

User Interface Elements

The following diagram shows the user interface elements of the Partner Dashboard:

The following table describes the user interface elements of the Partner Dashboard:

User
Interface
Element

Function

Mitel MiAccess
Identity

This is your name as provisioned in the Mitel MiAccess system. To change
this name, update your MiAccess profile.

Mitel MiAccess
Organization
Name

This is the name of your organization as provisioned in the Mitel MiAccess
system. To change this, an administrator can update your organization.

Avatar You can click this control and choose a photo or image to represent you.
This image will be present in CloudLink applications (e.g. Mitel One).
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User
Interface
Element

Function

Create
Customer

Use the Create Customer button to create a new customer in the CloudLink
platform.

Customer List A table appears below the Create Customer button displaying one row with
the following four columns of data for each of your customer accounts.

• Customer Name - Name of the customer account.
• Account ID - Unique ID for the account.
• Registered Users - Number of registered users for the account.

Click the linked number to view the Registered User List that shows
the Name, Extension, and Email Address for each registered user.

• Status Message - The current status indicates the next step in the
onboarding process (shown in blue) or an error that needs to be
resolved (shown in red). When the status displays Overview, this
indicates a successful customer deployment.

Links At the bottom of the Gateway Portal are the following links:

• Shortcuts - Useful keyboard shortcuts you can use while managing
customer accounts.

• Legal - Access to the CloudLink applications end user license
agreement.

• Help - Access to the online CloudLink help.
• Feedback - Access to the Mitel CloudLink UserVoice site

where you can suggest new or vote on existing ideas for future
development.

• Status - Access to the online status page for Mitel systems.

Customer List Status Messages

The current status of each customer is shown as a link on the right side of your list of customers.
Click anywhere in the list to navigate to an existing customer account. If there is a problem
with a customer's account, that information is displayed in red with a brief explanation to help
troubleshoot the issue. Click the linked error message to learn more. When the status displays
Overview this indicates a successful customer deployment. The following shows typical status
messages for a customer account.
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Creating a New Customer

Click the Create Customer button to create a new customer in the CloudLink Platform then follow
the instructions in Enter Customer Information. From here you can proceed to associate the
customer with a CloudLink Gateway and connect or sync the CloudLink Gateway to the PBX.

Modifying an Existing Customer

Click anywhere in the row of an existing customer to navigate to the customer and modify
the existing connection to the CloudLink Platform or the PBX. You can also do this to perform
troubleshooting.

The CloudLink Gateway Portal can be accessed from anywhere with an Internet connection to
modify or delete an existing customer.

Note:
To properly associate a Gateway with a new customer on the CloudLink platform,
you must first access the CloudLink Gateway Portal by connecting to the Gateway.
After a customer has already been associated with a Gateway, you can access the
CloudLink Gateway Portal directly or via Mitel MiAccess to onboard and manage
customers. To learn more, see Access the CloudLink Gateway.
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1.4 Best Practices for Site Deployments

The following is a list of best practices recommended for CloudLink site deployments:

• If there is no DHCP server on site, configure a MiVoice Office PBX or use another
DHCP server.

• For standalone platforms, the CloudLink Gateway appliance and MiVoice Office PBX
should be installed on the same LAN subnet. If this is not done, disable all SIP ALG
functions in the firewall to enable communication between these two components.
Additionally, ensure that port blocking is disabled.

• When you configure a firewall, ensure that the path to the Internet is open before you
set the site rules.

• For remote access management, separate the data networks from the voice networks.
• Ensure that your end-user mobile carrier supports propagation of incoming caller ID.
• To ensure that the Welcome/Deployment emails do not get rejected by the mailbox,

you must include the * .mitel.io alias in the user's e-mail whitelist.
• Ensure that the user database in the MiVoice Office PBX is updated accurately and

User Groups are labeled with informative names to enable importing contacts into
CloudLink applications such as Mitel One.

• CloudLink solution supports the following emergency numbers: 000, 110, 111, 112, 118
119, 911, and 999, which are specific to each supported country. To ensure that there
are no dialing conflicts, the administrator must configure these emergency numbers in
MiVoice Office 400.

• To ensure optimal network efficiency with free flow of data using minimum network
bandwidth, you must enable Bandwidth Optimization. For more information about
how to enable Bandwidth Optimization, see Account Information in CloudLink
Accounts documentation. To learn more about Bandwidth Optimization, see System
Requirements in CloudLink Platform documentation.

• Ensure that you enter the IP Address or FQDN value that is displayed in the Network Element
form. For more information about entering PBX information see, Enter PBX Information.

• It is strongly recommended not to deploy CloudLink directly on the Wide Area Network
to ensure that the CloudLink solution is properly secured. See the following Mitel KMS
articles related to Network Security and Toll Fraud prevention for the Mitel Office PBX
installations:

• Preventing Toll Fraud
• Toll Fraud prevention on SIP trunks
• General Guidelines to Secure SIP trunks for Toll Fraud prevention

For more information about configuring the firewall for CloudLink deployments, see Configuration
Prerequisites on page 8.

http://media.api.mitel.io/
https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/cloudlink-accounts-html
https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/cloudlink-accounts-html
https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/cloudlink-platform-html
https://mitel.custhelp.com/ci/okcsFattach/getFile/1001284/04-5190-00001_1.doc
https://mitel.custhelp.com/ci/okcsFattach/getFile/1001637/13-5191-00310_SIP_TF_Sup-V1.doc
https://mitel.custhelp.com/app/answers/answer_view/a_id/1001637/loc/en_US/s/16777222_5192c352b531-4cf6-4333-91e6-6ecae96f3d69_SEARCH/prTxnId/660011162/txnId/660011162#__highlight


Configuration Prerequisites 2
• Performance Profiles
• Network View
• CloudLink Platform IP Address Ranges
• Accounts Console
• CloudLink Gateway
• Connections Between the CloudLink GW and PBX/Call Server
• Mitel One Web
• Mitel One Mobile
• CloudLink Chat Integration
• Mitel Assistant
• MiTeam Meetings

This chapter is intended to inform customer Administrators about the performance profile and network
requirement prerequisites that must be ensured for the proper functioning of CloudLink enabled
applications, services, and devices.

The information provided helps customer Administrators in choosing the level of restrictions to impose
on the network equipment that they manage, based on the risk management capability they need to
achieve.

Note:
Any use of third-party links is subject to the terms of service, terms of usage, and
permission notices of the third-party content provider and is in no way intended to
circumvent the site owner's navigational structure or attempt to obtain materials or
information through means not purposely made available through the site(s).

2.1 Performance Profiles

Performance profiles are designed to allow the correct resource to best fit a solution for a
customer's requirements.

Profiles are selected by the gateway platform based on the platform type, the number of CPUs/
cores, and the amount of physical memory allocated. The call manager connected to the gateway
has no influence on the selection of the performance profile.
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Performance profiles have been defined by reflect the results of Mitel performance testing.
Specific characteristics of the gateway depend on the connected call manager and other
environmental factors.

All Platforms

For more information about the network requirements of performance profiles, see CloudLink
Gateway Performance Profile section in CloudLink Gateway.

Rank Profile CPU/RAM Sim. Calls (Mite
l One)

Memory Cloud
Link/FreeSWI
TCH

25 Small 1 Core / 1 GiB 25 256 MiB / 512 MiB

Virtual Appliance

Note:
Ensure that you have VMware environment (ESXi 6.0, 6.5 and 6.7, vSphere 6.0 and
6.5, vCenter Server 6.0 and 6.5)

Rank Profile CPU/RAM Sim. Calls (Mite
l One)

Memory Cloud
Link/FreeSWI
TCH

28 Small Plus 2 cores / 2GiB 40 256MiB / 1 GiB

30 Medium 4 cores / 2GiB 30 256MiB / 512MiB

125 Large 8 cores / 4GiB 125 512MiB / 2GiB

Note:
The profile Small Plus is created based on performance tests with MiVoice Office
5000 in a KVM environment.

MSL (on SMBC MiVoice Business only)
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Note:
The CloudLink gateway must have MSL 11.0 or later.

Rank Profile CPU/RAM Sim.Calls (Mitel
 One)

Memory Cloud
Link/FreeSWI
TCH

30 Medium 4 cores / 5GiB 30 1GiB / 512GiB

125 Large 8 cores / 5GiB 125 512MiB / 2GiB

Note:
FreeSWITCH on MSL is only available if a MiVoice Office 400 is installed on the
same system.

2.2 Network View

The following diagram illustrates a top-level network view of the various network connections.

Note:
Mitel One and the Accounts Console might also reside in the corporate network
behind the corporate firewall.
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2.3 CloudLink Platform IP Address Ranges

The CloudLink Platform and many of the sub-service providers leverage the Amazon Web
Services Platform for their infrastructure, Software as a Service, and Platform as a Service
needs.
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The IP address range required by the CloudLink Platform can be determined by using the IP
address range of the AWS region with which your CloudLink account is registered along with the
global IP range defined by AWS.

The following provides a list of AWS regions used by North America (NA), Europe, Middle East,
Africa (EMEA) and Asia Pacific (APAC).

• North America

• US East N. Virginia (us-east-1), and
• US West Oregon (us-west-2)

• Europe, Middle East, Africa

• Europe Frankfurt (eu-central-1), and
• Europe Ireland (eu-west-1)

• Asia Pacific

• Asia Pacific Sydney (ap-southeast-2)

For details, see AWS General Reference and select an IP address range that matches the AWS
regions mentioned with the service name AMAZON. The AWS global range is defined by a
service name GLOBAL.

For a global company with CloudLink accounts in multiple regions, Mitel recommends including
all regions in your firewall rules to ensure proper communication between regional offices.

The CloudLink Platform relies on a Content Delivery Network (CDN) called Amazon CloudFront.
Ensure that your IT infrastructure is enabled to support the CDN.

Examples of the IP address ranges which are expected can be found here.

2.4 Accounts Console

The following table lists network connections for the Accounts Console.

Note:

Examples of the IP address ranges which are expected can be found here.
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Purpose Direction Prot
ocol

Destination 
FQDN

Destination IP Port

Managed Services
provided by the
CloudLink Platform
including APIs, and
portals.

App to
Internet TCP *.mitel.io

See the CloudLink
Platform IP Address
Ranges section in
this document.

443

2.5 CloudLink Gateway

The following table lists the network connections from CloudLink Gateway to the external
destination unless specified.The rules used for establishing the connections assume a firewall
that permits return traffic on these established connections. This is referred to as pin hole
punching. If pin hole punching is not available or has been disabled on the firewall, then you must
exercise your own due diligence in configuring and testing the connections with the ports listed.

Note:

• ICMP must be enabled on the firewall.
• The CloudLink Gateway onboarding portal network configuration is different when

embedded with an MBG.

Examples of the IP address ranges which are expected can be found here.

Purpose Dire
ction

Prot
ocol

Domain Name IP Address Range Ports

NTP Service GW to
Internet UDP *.mitel.pool.

ntp.org

The public service assigns a
random set of servers on an
hourly basis.  It is not possible
to set an effective IP address
range.

123

DNS Service GW to
Internet UDP N/A DNS configured by the customer 53
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Purpose Dire
ction

Prot
ocol

Domain Name IP Address Range Ports

Managed
Services
provided by
the CloudLink
Platform
including APIs,
and portals

GW to
Internet TCP

*.mitel.io

mitel.io

See the CloudLink Platform IP
Address Ranges section in this
document.

443

STUN Service GW to
Internet UDP *.mitel.io

See the CloudLink Platform IP
Address Ranges section in this
document.

3478
and
3479

SIP
Connectivity

GW to
Internet TCP *.mitel.io

See the CloudLink Platform IP
Address Ranges section in this
document.

5061

RTP/SRTP
Connectivity
for CloudLink
Gateway
Appliance and
SMBC

Note:
See
performance
profile
considerations
in the
following
section
for virtual
and
embedded
variants.

GW to
Internet UDP *.mitel.io

See the CloudLink Platform IP
Address Ranges section in this
document.

16384
to
49152

and

65336
to
65534

CloudLink Gateway User Guide 14
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Purpose Dire
ction

Prot
ocol

Domain Name IP Address Range Ports

Reverse proxy
service which
the CloudLink
Gateway uses
to connect with
the CloudLink
Platform

GW to
Internet TCP *.ngrok.com

List of POPs provided by Ngrok
can be found here: ngrok
documentation

The service is hosted on AWS
and is configured to be in
the same AWS region as the
CloudLink Platform.

The IP address range for the
CloudLink Platform will cover
the ngrok service as listed in the
CloudLink Platform IP Address
Ranges section.

443

Required for
CloudLink
Single Sign-
On deployment
using Azure AD
federation

User
Browser
to
Internet

TCP
*.microsoftonline .com

*.microsoft.com

The IP address range published
by Microsoft is shown here:
  Office 365 URLs and IP
address ranges - Microsoft 365
Enterprise

See "ID 56" in the table of the
given link.

443

Gateway
onboarding
portal

User
Browser
to
Gateway

TCP Cloudlink.local Local IP address of the gateway
as configured on site. 80
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Purpose Dire
ction

Prot
ocol

Domain Name IP Address Range Ports

Note:
This row
is not
applicable
to an
MBG
scenario.
See the
MBG
Considerations
Section
below
for the
necessary
configuration.

2.5.1 MBG Considerations

The CloudLink Accounts Console is accessed differently when embedded within an MBG server.

The following table provides the required details:

Purpose Direction Protocol Domain N
ame

IP Address Range Ports

Gateway
onboarding portal

User Browser
to Gateway TCP

Domain
Name of
MBG Server

Local IP address
of the gateway as
configured on site

80

Gateway
onboarding portal
from MBG

User Browser
to Gateway TCP GW IP

address

Local IP address
of the gateway as
configured on site

8287

2.5.2 CloudLink Gateway Performance Profiles

The following tables provide information about the performance profiles of CloudLink Gateway.

For information about hardware requirements related to performance profiles, see Performance
Profiles.
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Profile Platform Purpose Direction Prot
ocol

Domain
Name

IP Address R
ange

Ports

Small CloudLink
Gateway
Appliance,
SMBC,
Virtual,
MiVoice
5000, and
MSL

RTP/
SRTP

GW to
Internet

UDP *.mitel.io See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384
to
49152

and

65336
to
65534

Small-
Plus

Virtual,

MiVoice
5000

RTP/
SRTP

GW to
Internet UDP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384
to
49152

and

65198
to
65534

Medium
Virtual,

MSL

RTP/
SRTP

GW to
Internet UDP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384
to
49152

and

65296
to
65534

Large
Virtual,

MSL

RTP/
SRTP

GW to
Internet UDP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384
to
49152

and

61536
to
65534
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2.6 Connections Between the CloudLink GW and PBX/Call
Server

This section provides details of network connections required between CloudLink Gateway and
the respective PBXs.

You must ensure that the ports on the Call Server or PBX are reserved for operational use for the
CloudLink Gateway and that the connections are routed properly through the corporate network.

Note:
Examples of the IP address ranges which are expected can be found here.

2.6.1 MiVoice Business Considerations

The following table summarizes the connection details of CloudLink Gateway with MiVoice
Business.

Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(Trunk from
PBX to GW)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site

5060

SIP

(TLS Trunk
from PBX to
GW)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5061

SIP

(Subscriber
Side)

GW to
PBX

TCP/
UDP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

5070
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Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(Subscriber
Side TLS)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5071

MiVB GDS for
user config

GW to
PBX TCP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

7011

SIP

(GW to Cloud
TLS Trunk)

GW to
CLoud TCP *.mitel.io

See the CloudLink
Platform IP Address
Ranges section in
this document.

5080,
5081

SIP

(Trunk from
PBX to GW for
SMBC only)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

19060

SIP

(LS Trunk using
TLS to GW for
SMBC only)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

19061

CTI Q2K Driver GW to
PBX TCP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

5320

2.6.2 MiVoice Office 400 Considerations

The following table summarizes the connection details of CloudLink Gateway with MiVoice Office
400.
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Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(Trunk from
PBX to GW)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

5060

SIP

(TLS Trunk
from PBX to
GW)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5061

SIP

(Subscriber
Side)

GW to
PBX

TCP/
UDP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

5070

SIP

(Subscriber
Side TLS)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5071

CTI Port GW to
PBX TCP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

7001
(default)

SIP

(GW to Cloud
TLS Trunk)

GW to
CLoud TCP *.mitel.io

See the CloudLink
Platform IP
Address Ranges
section in this
document.

5080,
5081

SIP

(Trunk from
PBX to GW for
SMBC only)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

19060
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Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(LS Trunk using
TLS to GW for
SMBC only)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

19061

Webhook for
MiVO400 user
config

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

8086

2.6.3 MiVoice MX-ONE Considerations

The following table summarizes the connection details of CloudLink Gateway with MiVoice MX-
ONE.

Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(Trunk from
PBX to GW)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

5060

SIP

(TLS Trunk
from PBX to
GW)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5061

SIP

(Subscriber
Side)

GW to
PBX

TCP/
UDP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

5070

SIP

(Subscriber
Side TLS)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5071
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Purpose Direction Protocol Domain Name IP Address Range Ports

CTI Port GW to
PBX TCP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

8882

SIP

(GW to Cloud
TLS Trunk)

GW to
CLoud TCP *.mitel.io

See the CloudLink
Platform IP Address
Ranges section in
this document.

5080,
5081

SIP

(Trunk from
PBX to GW for
SMBC only)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

19060

SIP

(LS Trunk using
TLS to GW for
SMBC only)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

19061

PBX user config PBX to
GW TCP cloudlink.local 

Local IP address
of the gateway as
configured in site .

8086 

2.6.4 MiVoice 5000 Considerations

The following table summarizes the connection details of CloudLink Gateway with MiVoice 5000.

Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(Trunk from
PBX to GW)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

5060
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Purpose Direction Protocol Domain Name IP Address Range Ports

SIP

(TLS Trunk
from PBX to
GW)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5061

SIP

(Subscriber
Side)

GW to
PBX

TCP/
UDP

Local domain name
of the PBX as
configured on site.

Local IP address
of the PBX as
configured on site.

5070

SIP

(Subscriber
Side TLS)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

5071

CTI Port GW to
PBX TCP

Local domain name
of the PBX as
configured on site

Local IP address
of the PBX as
configured on site.

3211

SIP

(GW to Cloud
TLS Trunk)

GW to
CLoud TCP *.mitel.io

See the CloudLink
Platform IP Address
Ranges section in
this document.

5080,
5081

SIP

(Trunk from
PBX to GW for
SMBC only)

PBX to
GW

TCP/
UDP cloudlink.local

Local IP address
of the gateway as
configured on site.

19060

SIP

(LS Trunk using
TLS to GW for
SMBC only)

PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

19061
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Purpose Direction Protocol Domain Name IP Address Range Ports

PBX user config PBX to
GW TCP cloudlink.local

Local IP address
of the gateway as
configured on site.

8086

2.7 Mitel One Web

The following table lists the connections from Mitel One to the external destination unless
specified.  The rules used for establishing the connections assume a firewall that permits return
traffic on these established connections. This is referred to as pin hole punching. If pin hole
punching is not available or has been disabled on the firewall, then you must exercise your own
due diligence in configuring and testing the connections with the ports listed.

Note:

• The port requirements for WebSockets are given here: Device communication
protocols - AWS IoT Core.

• If you are using a proxy server, ensure that it proxies WebSockets and HTTPS.
• The Mitel One web application uses WebRTC. By default, the CS0 value is set to

the same as the DSCO value.
• Check using Amazon Chime Readiness Checker whether your firewall rules

require updating for AWS Chime support.
• For more information about VPN recommendations and network requirements, see

Network Handling and Requirements.
• For AWS Chime rules, see Hosts, Ports and Protocols needed for Amazon Chime

services - Amazon Chime Help Center. The CloudLink Platform IP address ranges
in AWS will cover the AWS IP address ranges mentioned in the document link.
For details, see the CloudLink Platform IP Ranges section in this document. In
addition, the highlighted feature used is Amazon Chime Meetings, Chat, and
Business Calling.

• ICMP must be enabled on the firewall.
• Source port numbers are typically managed by the network stack.
• For more details about the media flow, see CloudLink Platform.
• * The RTP/RTCP source port range for the softphone is automatically selected by

WebRTC or the OS, respectively. There are no restrictions on the port range.

Examples of the IP address ranges which are expected can be found here.
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

Managed
Services
provided by
the CloudLink
Platform
including APIs
and portals

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

443

STUN Service App to
Internet UDP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

3478 and
3479

DNS Service GW to
Internet UDP N/A

Customer’s
configured
DNS

53

WebRTC
Connectivity *

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

7443

RTP/SRTP
Connectivity

App to
Internet USP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384 to
49152

WebSocket
Connectivity

App to
Internet TCP *.amazonaws.com

See the
CloudLink
Platform
IP Address
Ranges

See note on
WebSocket
above
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

section in this
document.

Meet Capability App to
Internet

TCP
and
UDP

See note on AWS
Chime above

See note on
AWS Chime
above

See note
on AWS
Chime
above

Google Cloud
Resources

App to
Internet TCP

*.gstatic.com

*.googleapis.com

Google IP
address
ranges can
be found
here: Obtain
Google IP
address
ranges -
Google
Workspace
Admin Help

(See "IP
ranges that
Google
makes
available to
users on the
internet" in
the given
link.)

443

cdnjs open-
source content
delivery network
hosed on
Cloudflare

App to
Internet TCP cdnjs.cloudflare.com

See IP
Ranges
Cloudflare

443

Required for
CloudLink
Single Sign-
On deployment
using Azure AD
federation

App to
Internet TCP

*.microsoftonline.com

*.microsoft.com

The IP
address
range
published by
Microsoft is
shown here:
  Office 365
URLs and

443
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

IP address
ranges -
Microsoft 365
Enterprise .

See "ID 56"
in the table of
the given link.

Bugsnag
Troubleshooting
service

App to
Internet TCP See BugSnag firewall

rules
See BugSnag
firewall rules 443

LaunchDarkly
feature flag
management

App to
Internet TCP See Domain List See Public IP

list 443

2.8 Mitel One Mobile

The following table lists the connections from Mitel One to the external destination unless
specified.  The rules used for establishing the connections assume the firewall that permits return
traffic on these established connections.   This is referred to as pin hole punching. If pin hole
punching is not available or has been disabled on the firewall, then you must exercise your own
due diligence in configuring and testing the connections with the ports listed.
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Note:

• The port requirements for WebSockets are given here: Device communication
protocols - AWS IoT Core.

• If you are using a proxy server, ensure that it proxies WebSockets and HTTPS.
• For more information about the ports and hosts used for Apple Push Notification

service (APNs), see Apple documentation (If your Apple devices aren't getting
Apple push notifications).

• For more information about configuring your firewall to connect a device with
Firebase Cloud Messaging (FCM), see Firebase Cloud Messaging.

• For more information about VPN recommendations and network requirements, see
Mitel One Mobile Application User Guide.

• ICMP must be enabled on the firewall.
• Source port numbers are typically managed by the network stack.
• For details about the media flow, see CloudLink Platform.
• * The RTP/RTCP source port range for the softphone is automatically selected by

WebRTC or the OS, respectively. There are no restrictions on the port range.

Examples of the IP address ranges which are expected can be found here.

Purpose Direction Prot
ocol

Destination FQDN Destination IP Port

Managed
Services
provided by
the CloudLink
Platform
including APIs,
and portals

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

443

STUN Service App to
Internet UDP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

3478 and
3479
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Purpose Direction Prot
ocol

Destination FQDN Destination IP Port

DNS Service GW to
Internet UDP N/A

Customer’s
configured
DNS

53

SIP Connectivity App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

5061

WebRTC
Connectivity*

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

7443

RTP/SRTP
Connectivity

App to
Internet USP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

16384 to
49152

WebSocket
Connectivity

App to
Internet TCP *.amazonaws.com

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

See
note on
WebSocket
above

Google Cloud
Resources

App to
Internet TCP

*.gstatic.com

*.googleapis.com

Google IP
address
ranges can be
found here:
Obtain Google
IP address

443
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Purpose Direction Prot
ocol

Destination FQDN Destination IP Port

ranges -
Google
Workspace
Admin Help
(See "IP
ranges that
Google makes
available to
users on the
internet" in the
given link.)

Required for
CloudLink
Single Sign-
On deployment
using Azure AD
federation

App to
Internet TCP

*.microsoftonline.com

*.microsoft.com

The IP
address range
published
by Microsoft
is shown
here: Office
365 URLs and
IP address
ranges -
Microsoft 365
Enterprise

See "ID 56" in
the table of the
given link.

443

Bugsnag
Troubleshooting
service

App to
Internet TCP See BugSnag firewall

rules
See BugSnag
firewall rules 443

2.9 CloudLink Chat Integration

This section provides details on firewall requirements for Mitel products that integrate CloudLink
Chat into their solution.  The details include conversations, notifications, presence, and SSO.

The following table lists the connections from the Mitel product to the external destination unless
specified. The rules used for establishing the connections assume a firewall that permits return
traffic on these established connections. This is referred to as pin hole punching. If pin hole
punching is not available or has been disabled on the firewall, then you must exercise your own
due diligence in configuring and testing the connections with the ports listed.
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Note:

• The port requirements for WebSockets are given here:  Device communication
protocols - AWS IoT Core.

• For Mobile deployments, the Chat Service leverages push notifications:

• For more information about the ports and hosts used for Apple Push Notification
service (APNs), see Apple documentation (If your Apple devices aren't getting
Apple push notifications).

• For more information about configuring your firewall to connect a device with
Firebase Cloud Messaging (FCM), see Firebase Cloud Messaging.

Examples of the IP address ranges which are expected can be found here.

Purpose Direction Prot
ocol

Destination FQDN Destination IP Destination 
Port

Managed
Services
provided by
the CloudLink
Platform
including APIs,
and portals

Server to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

443

DNS Service GW to
Internet UDP N/A Customer’s

configured DNS 53

WebSocket
Connectivity

Server to
Internet TCP *.amazonaws.com

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

See note on
WebSocket
above

Required for
CloudLink
Single Sign-On
deployment

Server to
Internet TCP

*.microsoftonline.com

*.microsoft.com

The IP address
range published
by Microsoft is
shown here:
Office 365
URLs and IP

443
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Purpose Direction Prot
ocol

Destination FQDN Destination IP Destination 
Port

using Azure
AD federation

address ranges
- Microsoft 365
Enterprise 

See "ID 56" in
the table of the
given link.

2.10 Mitel Assistant

For Call History Subscription, Mitel Assistant, like the Mitel One web application, uses a
WebSocket.

Note:

• The port requirements for WebSockets are given here: Device communication
protocols - AWS IoT Core.

• If you are using a proxy server, ensure that it proxies WebSockets and HTTPS.

Examples of the IP address ranges which are expected can be found here.

Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

Managed
Services
provided by
the CloudLink
Platform
including APIs,
and portals

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

443

DNS Service GW to
Internet UDP N/A Customer’s

configured DNS 53
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

WebSocket
Connectivity

App to
Internet TCP *.amazonaws.com

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

See note on
WebSocket
above

Microsoft Azure
AD APIs

App to
Internet TCP graph.microsoft.com

The IP address
range published
by Microsoft is
shown here:
  Office 365
URLs and IP
address ranges
- Microsoft 365
Enterprise

The entry of
interest the row
with ID 56 in the
table.

  443

LaunchDarkly
feature flag
management

App to
Internet TCP See Domain List See Public IP

List 443

2.11 MiTeam Meetings

The following table lists the connections from MiTeam Meetings to the external destination unless
specified. The rules used for establishing the connections assume a firewall that permits return
traffic on these established connections. This is referred to as pin hole punching. If pin hole
punching is not available or has been disabled on the firewall, then you must exercise your own
due diligence in configuring and testing the connections with the ports listed.
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Note:

• The port requirements for WebSockets are given here: Device communication
protocols - AWS IoT Core.

• If you are using a proxy server, ensure that it proxies WebSockets and HTTPS.
• Check using Amazon Chime Readiness Checker whether your firewall rules

require updating for AWS Chime support.
• For more information about VPN recommendations and network requirements, see

Network Handling and Requirements.
• For AWS Chime rules, see Hosts, Ports and Protocols needed for Amazon Chime

services - Amazon Chime Help Center. The CloudLink Platform IP address ranges
in AWS will cover the AWS IP address ranges mentioned in the document link.
For details, see the CloudLink Platform IP Ranges section in this document. In
addition, the highlighted feature used is Amazon Chime Meetings, Chat, and
Business Calling.

• ICMP must be enabled on the firewall.

Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

Managed
Services
provided by
the CloudLink
Platform
including APIs
and portals

App to
Internet TCP *.mitel.io

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

443

DNS Service GW to
Internet UDP N/A

Customer’s
configured
DNS

53

WebSocket
Connectivity

App to
Internet TCP *.amazonaws.com

See the
CloudLink
Platform
IP Address
Ranges
section in this
document.

See note on
WebSocket
above
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

Meet Capability App to
Internet

TCP
and
UDP

See note on AWS
Chime above

See note on
AWS Chime
above

See note
on AWS
Chime
above

Google Cloud
Resources

App to
Internet TCP

*.gstatic.com

*.googleapis.com

Google IP
address
ranges can
be found
here: Obtain
Google IP
address
ranges -
Google
Workspace
Admin Help

(See "IP
ranges that
Google
makes
available to
users on the
internet" in
the given
link.)

443

Required for
CloudLink
Single Sign-
On deployment
using Azure AD
federation

App to
Internet TCP

*.microsoftonline.com

*.microsoft.com

The IP
address
range
published by
Microsoft is
shown here:
  Office 365
URLs and
IP address
ranges -
Microsoft 365
Enterprise .

See "ID 56"
in the table of
the given link.

443
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Purpose Direction Prot
ocol

Domain Name IP Address R
ange

Ports

Bugsnag
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• Install the CloudLink Gateway Appliance
• Gateway Appliance Software Update
• Access the CloudLink Gateway
• Install the CloudLink Gateway in a VMware Virtual Environment
• Replace a Gateway Appliance
• Console Menu for CloudLink Gateway

The CloudLink Gateway appliance has the following characteristics:

• For standalone platforms, the CloudLink Gateway can be deployed as:

• an external device installed on premise to provide a connection from the PBX to the
CloudLink platform.

• a virtual instance of CloudLink Gateway installed in the VMware vCenter server. For
more information see, Install the CloudLink Gateway in a VMware Virtual Environment
on page 45.

• a blade on the virtual instance of MSL in VMware or Hyper-V environments with MiVoice
Office 400 already installed. For more information see, Configure MiVO400 on Virtual
Appliance on page 100.

• For SMBC platforms, it is installed as a software package on the same SMBC hardware.
• CloudLink Platform is integrated as a virtual instance using a KVM image on both EX Controller and

Compact Server (for MiVoice Office 5000).

See the topics listed below to learn how to install and access the CloudLink Gateway.

3.1 Install the CloudLink Gateway Appliance

The CloudLink Gateway appliance, which connects your PBX to the Mitel CloudLink platform,
should be connected to a DHCP-enabled LAN.

Prerequisites

This CloudLink Gateway requires the following:

• An Internet connection that provides sufficient bandwidth.
• A DHCP server to assign an IP address to the Gateway (not mandatory in VMware

environments).
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• A DNS server that the Gateway uses to resolve domain names.
• An Ethernet connection to the LAN.
• For more information about specific network configuration see, CloudLink Gateway.

Virtual Environment

To install CloudLink Gateway in a virtual environment, see Install the CloudLink Gateway in a
VMware Virtual Environment.

SMBC Platforms

If you have a MiVO400 PBX on an SMBC platform, which has an embedded Gateway, the
following information about assigning an IP address and connecting the appliance is not
applicable. Click here to go to the Gateway Applicance Software Update topic.

Assigning an IP Address

When the Gateway is powered up, it will acquire an IP Address from a DHCP Server on the LAN

The PBX needs to be programmed with the IP address of the CloudLink Gateway. This means a
fixed IP address must be allocated to the Gateway.

There are several different ways you can do this:

• Configure a static IP address (recommended). See Configure the Customer Site for
related information.

• Configure your DHCP server to reserve an IP address for the CloudLink Gateway
appliance.

• Your DHCP server may automatically reallocate the same IP address to the CloudLink
Gateway appliance.

Consult your DHCP server documentation to learn more about the server’s IP address allocation
scheme

Connecting the Appliance

1. Connect the CloudLink Gateway to the LAN using port 1.

2. Apply power.
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3. The CloudLink Gateway automatically accesses the Internet to download and install
any Software Updates. To learn more, see the Gateway Appliance Software Update
topic.

Warning:

If you have a Check Point "Security Gateway" firewall, unless special configuration steps are
taken, the CloudLink Gateway and client cannot register SIP TLS (Transport Layer Security)
through the firewall. To resolve this, the person in your organization who manages the Check
Point firewall should review the following two Check Point issues:

• sip_tls_authentication Service does not traverse the Security Gateway
• Unable to connect to Skype application using port 5061 with pre-defined TCP

service

3.2 Gateway Appliance Software Update

Mitel recommends that you enable and schedule automatic updates for the Gateway appliance in
the CloudLink Gateway Portal. To learn more, see Configure Advanced Settings and Options.

If you access the Gateway appliance while it is performing a software update, the progress status
is displayed. If the software update fails, you will be provided with recovery options.

The Gateway appliance checks for, downloads, and installs software updates from Mitel
whenever it is powered on or an automatic update is scheduled. Software updates vary in size
and can be as large as 500-700 MB.

Downloading and installing software updates typically takes about 10 to 15 minutes. The actual
time that it takes to download the updates depends on your Internet connection speed.

Note:
CloudLink Gateway is built on the CentOS operating system. The OS level updates
come from CentOS community update servers.
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Warning:
If you have a standalone platform with external Gateway, do NOT disconnect power
or the LAN cable until the update process has completed or within 15 minutes of
powering up the Gateway. Powering down or disconnecting the Gateway from the
network in the middle of an update can cause the update to fail and the Gateway to
not boot up properly.

Whenever the Gateway appliance is rebooted or restarted, you may see a brief display of a Lost
trunk connection to PBX message. This temporary issue should resolve itself.

When you connect your browser to the Gateway appliance, if the Gateway is still downloading
updates, you may see the System update in progress screen as shown below.

If your browser loses connection to the Gateway during the update, you may see the Lost
Connection to Gateway screen as shown below:

CloudLink Gateway User Guide 40



Install and Access the CloudLink Gateway

If there is an error while downloading the update, you may see an Update Error screen as
shown below.

If you have a standalone platform with external Gateway and there are downloading errors, you
can take appropriate action as explained below:

• Retry should be attempted if the error message indicates a connection failure or
a problem that you have the ability to resolve. For example, if there is a firewall
configuration error, you should use the Retry option after resolving the error.

• Reboot should be attempted if retry fails to resolve the problem.
• Factory Reset can be attempted if you suspect the Gateway received a bad update

from Mitel or you received guidance from Mitel Support to do a Factory Reset.

If you have an SMBC platform with embedded Gateway and there are downloading errors, an
administrator can apply the Restart command to the Mitel-CloudLink Gateway in the Software >
Applications screen of the SMB Controller Manager admin console as shown below.

If these errors persist, contact Mitel Partner Technical Support via a login at https://
www.mitel.com/en-ca/login.
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3.3 Access the CloudLink Gateway

To properly associate a Gateway with a new customer account on the CloudLink platform, the
CloudLink Gateway Portal must be accessed the first time as indicated below.

• For standalone platforms, which have an external Gateway, the Portal must be
accessed the first time by connecting to the Gateway from the same LAN subnet.

• Details are in the Portal Access for Standalone Platforms section of this topic.

• For SMBC platforms, which have an embedded Gateway, the Portal must be
accessed the first time from the SMB Controller Manager.

• Details are in the Portal Access for SMBC Platforms section of this topic.

After a customer has been associated with a Gateway, you can access the CloudLink Gateway
Portal to manage customers in the following different ways:

• By connecting from the same LAN subnet to the Gateway at http://cloudlink.local/ (for
standalone platforms only)

• By accessing the Application configuration link in the SMB Controller Manager (for
SMBC platforms only)

• By accessing Mitel MiAccess at https://connect.mitel.com/
• By accessing the Gateway Portal directly at https://mitel.io/cloudlink/gateway

Note: Internet Explorer (IE) does not properly display pages in the CloudLink Gateway Portal.

3.3.1 Update Progress

When you connect your browser to the Gateway appliance, if the Gateway is still downloading
updates, a 'system update in progress' message is displayed.

If your browser loses connection to the Gateway during an update, a 'Lost Connection to
Gateway' message is displayed.

If there is an error while downloading the update, an 'Update Error' message is displayed.

If your Gateway is rebooted, you may see a brief display of a 'Lost trunk connection to PBX'
message.

For more detailed information, see the Gateway Appliance Software Update topic.
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3.3.2 CloudLink Policy

To enable personnel to log into the CloudLink Gateway Portal via Mitel MiAccess, the CloudLink
policy must be assigned to individual users (or as part of a bundle) by a Partner Administrator
through the Mitel MiAccess user management portal. Please refer to the MiAccess Admin manual
for additional information.

3.3.3 Portal Access for Standalone Platforms

3.3.3.1 Associate Gateway with a Customer by
Connecting to Gateway

To associate an external Gateway with a customer account in the CloudLink platform, the
CloudLink Gateway Portal should be accessed by connecting a supported browser to the
Gateway at http://cloudlink.local/ or by entering the IP address of the gateway appliance in the
browser. This needs to be done from a computing device located on the same LAN subnet as the
CloudLink Gateway Portal. Unless the Gateway is currently being updated, the browser redirects
to the CloudLink Gateway Portal login page. In the login page, click the MiAccess button. In the
Mitel MiAccess login page that appears, enter your MiAccess credentials and click the Login
button. After a successful login, your name and avatar are displayed in the upper-right corner of
the interface.

Note:

The first time you connect to the Gateway (from the same LAN subnet), type the http:// prefix
explicitly in the browser's address bar as shown below:

http://cloudlink.local or http://ip.address.of.gateway

This is an important step that only needs to be done once. A browser normally stores this
information to make future connections to the Gateway.

You can use Apple Bonjour software to locate the Gateway when you connect from the LAN.
Apple Bonjour software, which is compatible with the CloudLink Gateway, is a zero-configuration
networking technology that locates devices such as printers and other computers, and the
services that those devices provide on a local network subnet. You can download and install
Apple Bonjour Print Services for Windows at https://support.apple.com/kb/dl999?locale=en_US.
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3.3.4 Portal Access for SMBC Platforms

Associating an embedded Gateway with a new customer account on the CloudLink platform
must be done via the SMB Controller Manager. For instructions, see the Access Application
Configuration Link section of the Configure MiVO400 on SMBC Platform topic.

3.3.5 Portal Access for All Platforms

The following two additional ways to access the CloudLink Gateway Portal apply to both
standalone platforms (with external Gateway) and SMBC platforms (with embedded Gateway).

3.3.5.1 Access the CloudLink Gateway Portal via
Mitel MiAccess Portal

To perform maintenance on a customer account already associated with a Gateway, access
the CloudLink Gateway Portal by logging in to the Mitel MiAccess Portal using your MiAccess
credentials. In the MiAccess Portal home page, CloudLink Gateway Portal will be listed on the
left side of the site, if the CloudLink policy has been assigned to you. Click CloudLink Gateway
Portal. The Gateway Portal opens and the Partner Dashboard is displayed.

3.3.5.2 Access the CloudLink Gateway Portal via
Direct Access

A Mitel Partner or an administrative user of a customer account can access the CloudLink
Gateway Portal directly at http://gateway.mitel.io/.
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For information about logging in to the Gateway portal directly, see Log in to CloudLink Gateway
Portal.

3.4 Install the CloudLink Gateway in a VMware Virtual
Environment

This topic describes the equipment, network, and configuration considerations that apply when
setting up CloudLink Gateway on servers enabled with VMware® vSphere™ virtualization.

.

3.4.1 System Requirements

For information about VMware requirements see, Performance Profiles.
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Note:

• You must have VMware vCenter server installed in your machine to change the network
configuration of the gateway during the deployment.

• The CloudLink appliance and the MiVoice Office PBX must be installed on the same
virtual environment / LAN subnet. If this is not done, disable all SIP ALG functions in the
firewall to enable communication between these two components. Additionally, ensure
that port blocking is disabled.

• CloudLink Gateway does not support virtualization features related to application
migrations, for example vMotion.

3.4.2 Assigning IP Address

During the virtual deployment of CloudLink Gateway, the system assigns the initial IP address
through Dynamic Host Configuration Protocol (DHCP). Alternately, the user can configure the
initial IP address during the Open Virtualization Application (OVA) deployment using the portal.
The console displays the network address after the deployment.

3.4.3 Deployment

You can deploy CloudLink Gateway in a VMware environment in any of the following ways:

3.4.3.1 Deploy using VMware vSphere/vCenter

The following are the high-level steps to deploy CloudLink Gateway OVA using the VMware
vSphere Client to an ESXi host via vCenter Manager.

1. Log in to the VMware vSphere Client with your username and password.
2. From the vSphere Client Menu Bar, choose File > Deploy OVF Template.
3. In the OVA Wizard, select the Source of the OVF template file (OVA file extension)

a. URL

i. If the OVF template file is on the Internet or accessible through a web browser;
enter the URL of the location of the file.

b. Local File

i. If the OVF template file was downloaded to the local computer or to a network
share drive, click Browse to locate the file.

4. Click Next.
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5. Under Name and Inventory Location, specify the name for the virtual machine and
click Next.

6. Under Deployment Configuration, select the desired hardware configuration profile from the
drop-down menu.

7. Click Next.
8. Under Storage, select the Datastore to use for the virtual machine. Click Next.
9. Set the virtual disk format to Thick Provisioned.

10. Under Network Mapping, allocate one virtual network interface card (vNIC) on the destination
network using the drop-down list. The options for mapping the vNICs differ depending on the
release version.

11. Configure the properties for the virtual machine.
12. Select Power on after deployment to automatically power on the virtual machine.
13. Click Finish to deploy the OVA.

3.4.3.2 Deploy using VMware Open Virtualization
Format Tool

Alternately, use the command ovftoolto deploy CloudLink Gateway in a VMware environment
through the VMware Open Virtualization Format Tool. The configuration parameters such as
static IP address, user name, and password can be specified when deploying the OVA package
to an ESXi host.

The following is an example of how to deploy CloudLink Gateway in a VMware environment
using the command.

# target host
# (replace values as needed for your environment)
ESXI_DATASTORE=datastore1
ESXI_USERNAME=root
ESXI_PASSWORD=password
ESXI_HOST=198.51.100.10
# network settings for virtual CloudLink Gateway
# (replace values as needed for your environment)
DEPLOYMENT_IP=198.51.100.20
DEPLOYMENT_NETMASK=24
DEPLOYMENT_GATEWAY=198.51.100.1
DEPLOYMENT_DNS=198.51.100.1
DEPLOYMENT_HOST_NAME=cloudlink.domain.com 

ovftool \
    --acceptAllEulas \
    --disableVerification \
    --noSSLVerify \
    --skipManifestCheck \
    --X:injectOvfEnv \
    --powerOn \
    --prop:cl.hostname=${DEPLOYMENT_HOST_NAME} \
    --prop:cl.ip0=${DEPLOYMENT_IP} \
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    --prop:cl.netmask0=${DEPLOYMENT_NETMASK} \
    --prop:cl.gateway0=${DEPLOYMENT_GATEWAY} \
    --prop:cl.dns0=${DEPLOYMENT_DNS} \
    --datastore=${ESXI_DATASTORE} \
    Mitel-CloudLink-Gateway-1.0.0.ova \
    "vi://${ESXI_USERNAME}:${ESXI_PASSWORD}@${ESXI_HOST}/"

3.5 Replace a Gateway Appliance

If the CloudLink Gateway appliance linked with a CloudLink customer account was factory reset
or replaced, you must re-link the new Gateway appliance with the CloudLink customer account to
re-establish the account’s connection to the PBX.

The following table lists the platforms that are supported for re-linking after the platform type is
changed.

Origin /
Destination

Hardware
Appliance

Virtual
Appliance

SMBC Embedded
on MiVO400
MSL

KVM
(MiVoice
5000)

Hardware
Appliance

Supported Supported Not supported Not supported Not supported

Virtual
Appliance

Supported Supported Not supported Not supported Not supported

SMBC
Not supported Not supported Supported Not supported Not supported

Embedded
on MiVO400
MSL

Not supported Not supported Not supported Supported Not supported

KVM
(MiVoice
5000)

Not supported Not supported Not supported Not supported Supported
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Note:

• If you are replacing a Gateway type that is not supported, you must first remove the
CloudLink Gateway integration then add CloudLink Gateway integration. After adding the
CloudLink Gateway integration, perform the gateway deployment, following the standard
installation process for the gateway type being deployed.

.

Perform the following steps to replace and re-link a Gateway appliance.

1. Install the new Gateway appliance.
2. Access the CloudLink Accounts Console to onboard the new gateway appliance as

indicated below:

• For standalone platforms, which have an external gateway, access the CloudLink
Accounts Console by doing either of the following:

• enter the IP address of the gateway appliance in a supported browser.
• connect a supported browser to the gateway at http://cloudlink.local/.

Note:
To access the gateway using http://cloudlink.local/ your system must support
mDNS. For Windows, this support can be downloaded and installed with
Bonjour Print Services. You must do this from a computing device located on
the same LAN subnet as the CloudLink Gateway. For more information, see
Access the CloudLink Gateway. 

After successful login, the gateway will redirect you to the CloudLink Accounts Console.
• For SMBC platforms, which have an embedded gateway, access the CloudLink

Accounts Console from the SMB Controller Manager. For more information, see
Access the CloudLink Gateway on page 42.

After successful login, the gateway will redirect you to the CloudLink Accounts Console.
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3. In the accounts list, click the CloudLink customer account associated with the old
CloudLink Gateway appliance, which will show the status as Lost Connection to
gateway.

4. In the Integrations panel, click the  icon associated with CloudLink Gateway
integration. After you have entered the CloudLink Gateway integration page, the
CloudLink Gateway portal tries to establish a connection with the old CloudLink
Gateway appliance. Because the connection will not be successful, a page opens
displaying a Connection Failure error.
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5. In the Connection Failure error page, select the check boxes against the two
confirmation questions and click Link to new Gateway.

Note:

• If you do not select both check boxes, the new CloudLink Gateway appliance
will not be linked to the CloudLink customer account.

• If the Link to new Gateway option is disabled and the error message No
Gateway detected for linking is displayed, you must first access the CloudLink
Accounts Console by following the instructions described in Step 2.

6. One of the following pages will be displayed:

• The CloudLink gateway network configuration page is displayed if you are
connecting a gateway appliance that has a similar network configuration to the
appliance previously connected to this account. The Configuration on gateway
to be linked option is selected by default. Review the information and click
Continue. The CloudLink gateway network configuration page is displayed if
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you are connecting a gateway appliance that has similar network configuration to
the appliance connected to this account. The Configuration on gateway to be
linked option is selected by default. Review the information and click Continue.

• The Choose CloudLink gateway network configuration page is displayed if
you are connecting a gateway appliance with a network configuration that is not
similar to the appliance previously connected to this account. Select Configuration
stored in the cloud to continue with previous network configuration or select

CloudLink Gateway User Guide 52



Install and Access the CloudLink Gateway

Configuration on gateway to be linked to continue with the new the network
configuration on the gateway appliance. Click Continue.

A re-link confirmation panel opens.
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7. Type the word “link” in the text box that appears within the panel, and click Link to
new Gateway.

The CloudLink Gateway integration attempts to establish a connection to the new CloudLink
Gateway appliance. If the account previously had a PBX connected, that connection will also
be re-established.
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Depending on the platform (standalone or SMBC), either the Connect page or the Sync page
is displayed when the new CloudLink gateway appliance is linked to the Cloudlink customer
account and the PBX connection is re-established.
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8. After successful configuration of the gateway, the status message associated with
CloudLink Gateway in the Integrations panel changes to Onboarding Complete as
shown below.

3.6 Console Menu for CloudLink Gateway

The Console menu in CloudLink Gateway allows commands to be run locally for the physical
and the virtual gateway. Functions such as Data Reset, Factory Reset, Enable/Disable SSH
access for Mitel support, Ethernet configuration, Hostname, and Download logs can be
performed using these commands.
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To access the Console menu, press ALT+F2 for Windows and FN+F2 for MAC.

To exit the Console menu and return to home screen, press ALT+F1 for Windows and FN+F1 for
MAC.

Data Reset

Data Reset allows you to reset the data that is stored on the gateway during onboarding.

Factory Reset

Factory Reset allows you to reset the boot and root partitions to factory default. During a factory
reset process, the application reboots, starts the recovery system, and then restores the boot and
root partition. This process may take 15-20 minutes.

For virtual gateways, Factory Reset option is not available. To do a factory reset, redeploy and
follow the deployment guide.

Enable/Disable SSH access

By default, SSH access is disabled. SSH will be requested only by Mitel support to investigate
customer issues. Selecting the SSH option enables SSH on the physical gateway for 24 hours
unless it is disabled manually within this time. When SSH is enabled, a line of text is displayed
above the Menu option indicating that SSH is enabled.

Ethernet configuration and Hostname

Ethernet configuration and Hostname allows you to configure local IPv4 settings and hostname of
the gateway.

Download logs

The Download logs option can be used to download logs in cases where the gateway does
not connect to the CloudLink Platform. When you click Download logs, a confirmation box is
displayed with the message "Create an unreproducible and temporary log archive URL".
Click Yes to continue (the download takes up to couple of minutes). A temporary URL is created,
which expires after few minutes. To download the logs, type the URL into the browser of a
machine that has access to CloudLink Gateway. The log files will be downloaded automatically.
You can investigate the issue using plain text logs. For further assistance, share the logs as per
your standard support process.
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• Log in to CloudLink Gateway Portal
• Onboard Customers Using Navigation Bar or a Single Page
• Enter Customer Information
• Configure the Customer Site
• Enter PBX Information
• Connect or Sync the PBX
• Deploy the CloudLink App (optional)
• Configure Advanced Settings and Options

The topics listed below provide instructions for onboarding your customers, which is required to enable
customers to access CloudLink applications.

4.1 Log in to CloudLink Gateway Portal

A Mitel Partner or a user who has administrative rights over a user account can log in to the
CloudLink Gateway Portal directly through the URL https://gateway.mitel.io/.

To log in, a Mitel Partner must click the MiAccess button on the Gateway Portal login screen. In
the Mitel MiAccess login page, enter your MiAccess credentials and click LOGIN to log in to the
CloudLink Gateway Portal.

To log in, an administrative user must enter the email id (specified in the account for the user)
as the user name and the password (specified by the user while registering the account) as the
password, and click Next to log in to the CloudLink Gateway Portal.
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Note:
If a user’s email address is registered with multiple accounts, the system will identify
this (while you to log in) and prompt you to enter the Account ID of the account
(associated with the CloudLink application you want to log in to).

The CloudLink Gateway Portal opens and the Partner Dashboard is displayed. The following
image shows an example of the Partner Dashboard on page 3 when a Partner or an
administrative user logs in to the CloudLink Gateway Portal for the first time.
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4.2 Onboard Customers Using Navigation Bar or a Single
Page

You can onboard a customer in a step-by-step manner by clicking links in the navigation bar
or you can perform all steps from a single page by selecting the Overview option. Some of the
onboarding steps are different for the two supported platform types listed below:

Standalone Platform with External Gateway on page 60

SMBC/VA Platform with Embedded Gateway on page 61

Standalone Platform with External Gateway

The image below shows the onboarding steps for a standalone platform, which connects an
external Gateway to a MiVO400 PBX:

Onboarding a customer includes the following required and optional steps:

• Required

• Customer - Enter information about the customer including the mailing address and
admin contacts.

• Gateway-Enter information about the physical Gateway site or the virtual machine
and configure IP addresses to associate the Gateway with the CloudLink Platform.

• PBX - Enter information to configure the MiVoice Office PBX including the IP
address, CloudLink credentials, port number, and SIP trunk group credentials and
extension.

• Connect - Connect the PBX to the CloudLink Gateway and set the sync schedule.
• Optional

• Deployment - Deploy the CloudLink application associated with your PBX (for
example, Mitel One).

• Advanced - Configure advanced settings that can be used for troubleshooting
issues, usually while working with Mitel Support.
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For standalone platforms, see Enter Customer Information for details about the next step of the
onboarding process (Customer).

SMBC/VA Platform with Embedded Gateway

The image below shows the onboarding steps for an SMBC/VA platform, which syncs an
embedded Gateway to a MiVO400 PBX:

Onboarding a customer includes the following required and optional steps:

• Required

• Customer - Enter information about the customer including the mailing address and
admin contacts.

• Gateway-Enter information about the physical Gateway site.
• Sync- Sync the CloudLink Gateway to the PBX.

• Optional

• Deployment - Deploy the CloudLink application associated with your PBX (for
example, Mitel One).

• Advanced - Configure advanced settings that can be used for troubleshooting
issues, usually while working with Mitel Support.

For SMBC/VA platforms, see Enter Customer Information for details about the next step of the
onboarding process (Customer).

4.3 Enter Customer Information
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Note:

For SMBC/VA platforms, the Sync step is used instead of the PBX and Connect steps shown
above.

The Customer step of the onboarding process requires entering information about the customer
including defining domains and adding site administrators.

1. Enter the following information:

• Customer Information - Enter the customer's name and complete mailing
address (not necessarily the PBX location). Also be sure to select the most closely
associated value from the Business Type menu, which is used only as statistical
information to help Mitel better serve customers.

• Admin Contacts - Enter any number of contacts as site administrators to provide
these contacts with advanced privileges for managing CloudLink applications. For
example, in the Mitel One application, an administrator can add, change, or delete
other users from the account.

• Support Contacts - The Support Contacts for a customer account comprises
a Maintainer, Onsite Admin, or any Other contact added by the Partner user or
an administrative user of that account to whom all issue reports pertaining to that
account are sent.

• Maintainer: Maintains the system for the customer.
• Onsite Admin: Administrates the system from the site.
• Other: Any other user assigned to be a support contact for the customer

account.

When a customer reports an issue with a CloudLink application, an email is sent to the
Support Contacts. The Support Contacts are responsible for addressing the issues
reported by their customers and when needed, contact Mitel Partner Technical Support via
appropriate channels. To add a Support Contact, enter the name and email address of the
Maintainer, Onsite Admin, or any Other user as shown in the following figure.
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Note:
It is mandatory to add at least one Maintainer and Onsite Admin while
onboarding a new customer. You can add as many Support Contacts as you
want.

2. Click Next to continue to configure the Gateway. Click Cancel to discard the changes
and return to the Partner dashboard. If you are a Partner, you can click Save and
Back to save the changes and return to the Partner dashboard.

See Configure the Customer Site for information about the next step of the onboarding process
(Gateway).

4.4 Configure the Customer Site

Note:
For SMBC/VA platforms, the Sync step is used instead of the PBX and Connect steps
shown above.

The Gateway step of the customer onboarding process requires the following:
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For standalone, SMBC, and VA platforms, configure the customer's CloudLink Gateway site by
doing the following:

• In the Gateway Information area, enter the site name and complete address for the
physical location of the PBX if different from your business address (populated by
default).

Note:
The (preview) label associated with a country indicates that the country is recently
added to the list of countries that support complete deployment of the CloudLink
solution. If there are any issues, contact Mitel Partner Technical Support via
appropriate channels.

For standalone platforms, configure the Ethernet ports on the external Gateway appliance or on
the virtual machine by doing the following:

• In the Appliance Ethernet Configuration area, choose one of the following options.
You can configure your DHCP server to assign a fixed IP address to the CloudLink
Gateway or you can provide a static IP configuration. For more information about
these options, see the Assigning an IP Address section of the Install the CloudLink
Gateway Appliance topic.

• Select DHCP to enable your DHCP server to set the necessary IP addresses.
• Select Static to manually set the following IP addresses:

• IP Address (static IP address assigned to Port 1)
• Subnet Mask (subnet mask of the LAN to which Port 1 is connected)
• Default Gateway (IP address of the router that the CloudLink Gateway will use to

route IP traffic to the Internet)
• DNS Servers (IP addresses separated by commas with the primary DNS server

listed first)

For all platforms, click Save or Next.

For information about network view of various network connections see, Network View.

For standalone platforms, see Enter PBX Information for details about the next step of the
onboarding process (PBX).

For SMBC/VA platforms, see Connect or Sync the PBX for information about the next step of the
onboarding process (Sync).
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4.5 Enter PBX Information

The PBX steps of the customer onboarding process requires entering information about the PBX
to begin establishing a connection between it and the CloudLink platform.

Note:
The PBX step is required for standalone platforms only. For SMBC/VA platforms,
perform the steps described in Connect or Sync the PBX (used instead of the PBX
and Connect stepsshown above).
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1. Select the PBX Type. Depending on the type of PBX selected, enter information as
follows:

• For MiVoice Office 400:

a. PBX Name: Enter PBX name.
b. IP Address: Enter the IP address of the selected PBX.
c. Port: By default, the port is displayed. Enter the port number if it is different from the

default port number selected for the CSTA service during Configure a MiVoice Office 400
PBX on page 79.

d. CloudLink System Username: Enter the same user name entered during Configure
MiVO400 on Standalone Platform on page 83.

e. CloudLink System Password: Enter the same password entered during Configure
MiVO400 on Standalone Platform on page 83.

For both standalone and SMBC platforms, see Connect or Sync the PBX on page 71
for details about the next steps of the onboarding process (Connect or Sync).

• For MX-ONE:
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a. PBX Name: Enter PBX name.
b. IP Address: Enter the IP address of the selected PBX.
c. Port: Enter the port number if it is different from the default port number selected for the

CSTA service.

• For MiVoice Business:
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a. PBX Name: Enter the name that was entered in the MiVB Network Element form.
b. IP Address or FQDN: Enter the IP address or the FQDN value that is displayed in the 

MiVB Network Element form.

Note:
FQDN can be resolved to internal IP of MiVoice Business.

c. MBG IP Address or FQDN: Enter the MBG IP address or FQDN.
d. MBG Password: Enter the password.
e. Upload or modify the certificate.
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Note:
It is an optional step, perform this step only if you have custom certificate.

• Click Choose file and select the certificate from your local folder.

After you select the certificate, the certificate name is displayed under Upload
CA Root Certificate. To remove the selected certificate, click Remove CA Root
Certificate.

• If a certificate is already uploaded, the Previously uploaded certificate is displayed.
To upload a new certificate, you must remove the previous certificate by clicking
Remove CA Root Certificate and then upload the new certificate.
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Note:
If the data entered while configuring MiVoice Business is incorrect, the following
error might be displayed.

Error Message Possible Reason

MBG FQDN/IP address is invalid The MBG or FQDN IP address is not reachable

Could not update PBX Link Could not connect to the PBX

Failed to authorized MBG The MBG password is incorrect

• For MiVoice Office 5000:

a. PBX Name: Enter PBX name.
b. IP Address: Enter the IP address of the selected PBX.
c. Port: Enter the port number if it is different from the default port number selected for the

CSTA service.
2. Click Next if you are onboarding for the first time or click Save to save any changes

you have made.
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4.6 Connect or Sync the PBX

This step of the customer onboarding process is to connect or sync the Gateway to the PBX.

Connect or Sync your MiVO400 PBX to the CloudLink Gateway using the instructions below for
your platform type:

Standalone Platform with External Gateway on page 71

SMBC/VA Platform with Embedded Gateway on page 72

Standalone Platform with External Gateway

1. When you see the Start PBX Connection dialog, click the green Connect button. A
"Connection successful" message appears as shown below.

2. In the PBX Sync Schedule box, enter the number of minutes after which you want the
PBX to be synchronized again.

3. If an error message is displayed, see Troubleshoot Errors for information about
resolving errors.

4. Click Next.
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SMBC/VA Platform with Embedded Gateway

1. When you see the Sync PBX Data dialog, click the green Sync button. A "Sync
successful" message should appear as shown below. If this includes a warning
message about missing email addresses, click the view list of these users link to
identify the users who are missing an assigned email address in the PBX. Without an
assigned email address, a user cannot register their Mitel One application.

2. If an error message is displayed, see Troubleshoot Errors for information about
resolving an error.

3. Click Next.

Note:
For PBX users who have already been imported into CloudLink, any change in the
user name made on the PBX can be synced with CloudLink by clicking Sync option.

For both standalone SMBC platforms, see Deploy the CloudLink App  for details about the next
step of the onboarding process (Mitel One).
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4.7 Deploy the CloudLink App (optional)

This optional step of the customer onboarding process enables you to deploy the CloudLink
application.

Note:
For SMBC platforms, the Sync step is used instead of the PBX and Connect steps
shown above.

Deploying the Mitel One require sending deployment emails.

Send Deployment Emails

To specify the users to whom deployment emails will be sent, use the Select Users option (see
the following figure).

Clicking this option displays the Eligible user list (see the following figure) which lists all users
who have a configured email address in the MiVoice Office 250 PBX. To specify users to whom
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deployment emails (welcome emails) will be sent, select the checkbox beside their name and
then click Send Deployment Emails.

Note:
You cannot send deployment emails to eligible users who have the same email
address.

For both platforms (standalone and SMBC), see Configure Advanced Settings and Options for
information about the next and last (optional) step of the onboarding process (Advanced).

Finish building the Account

Users must click the Finish building your account button in the welcome email they receive
to register their information with Mitel and build an account to be able to log in to the Mitel One
Application. For more information see, Register and Access the Mitel One Web Application.
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Registered Users

To view a list of all users who have successfully completed building their user accounts, click the
Show Registered Users option. The Registered user list page opens (see the following figure),
listing the name, phone extension number, and the email address of all registered users.

For both platforms (standalone and SMBC), see Configure Advanced Settings and Options for
information about the next and last (optional) step of the onboarding process (Advanced).

4.8 Configure Advanced Settings and Options

Note:

For SMBC platforms, the Sync step is used instead of the PBX and Connect steps shown
above.

This step of the customer onboarding process enables selecting advanced settings and options
that are useful for troubleshooting issues, especially when working with Mitel Support.
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Advanced Settings

You can define leading digits for the following types of calls to manage conflicts for complex route
selection plans.

• Inbound Digits - Define digits that will be used to route calls directed from CloudLink
applications to the PBX.

• Outbound Digits - Define digits that will be used to route calls directed from the PBX
to CloudLink applications.

Automatic Update Schedule

When the Gateway installs an update, a short service outage can occur where users may have
trouble placing calls through the Gateway. It is recommended that you select an automatic
update time as shown below and click Save to minimize the impact of the service outage.
Note that updates are periodic, there may be no update when the schedule calls for an update
checkpoint, and not every update causes an outage.

Logs

Mitel product support may request logs from the Gateway if it is not connected to the CloudLink
platform. Use the Download Logs button to copy the logs to your browser so you can provide
them to Mitel support.
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Trace Calls

Mitel product support may request that you trace calls for a specific period of time during which
the Gateway can collect detailed information about your Voice Over IP (SIP) calls. You can then
download the traced call information to your browser so you can provide it to Mitel support. This
option is typically used for forensic analysis of degraded call quality.

System Options

If you have a standalone platform with an external Gateway, as a last resort, after consulting
with Mitel Support, you may need to use one of the System Options shown below:

• Factory Default – Choose this option to reset the Gateway to the factory default
settings. The Gateway will need to be reprogrammed after choosing this option. If
needed, contact Mitel Support for guidance.

Note:
The Factory Default option is available only for the physical gateway; it is not
available for the virtual gateway.

• Reboot – Choose this option to reboot the Gateway and recover service if the
Gateway is not working correctly.
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If you have an SMBC platform with an embedded Gateway, the System Options shown above
are not available. However, an administrator can apply the Restart command to the Mitel-
CloudLink Gateway in the Software > Applications screen of the SMB Controller Manager
admin console as shown below.

System Version

This section of the screen indicates when updates are available and enables you to apply the
updates immediately without waiting for the next scheduled update checkpoint.



Configure a MiVoice Office 400 PBX 5
• Configure MiVO400 on Standalone Platform
• Configure MiVO400 on SMBC Platform
• Configure MiVO400 on Virtual Appliance

The following deployments are supported for MiVoice Office 400 PBXs on the CloudLink Platform.

Supported Deployments

• MiVoice Office 400 PBX on a standalone platform with an external gateway

• M470 is supported (M430 and M415 are not supported)
• Virtual Appliance (VA) is supported

• MiVoice Office 400 PBX on an SMBC platform with an embedded gateway
• MiVoice Office 400 PBX on a VA platform with an embedded gateway

Prerequisites

• MiVoice Office 400 PBX Release 6.3 or later for embedded gateway on SMBC and external
gateway.

• MiVoice Office 400 PBX Release 7.0 or later for embedded gateway on VA.
• Requires current Software Assurance and end user licensing.
• The CloudLink Gateway must be on the Master Node in an AIN (Advanced Intelligent

Network) environment.
• The CloudLink Gateway for SMBC is required for SMBC platforms.
• The CloudLink Gateway for VA is required for VA platforms.

For more information about configuration prerequisites, see Configuration Prerequisites

Note:

CloudLink applications can be installed on a customer’s MiVoice Office 400 PBX along with most
other applications except the MiCollab client.

To find out whether a customer deployment has been successfully completed or whether more work
is required, access the Partner Dashboard in the CloudLink Gateway Portal and view the status
message for the desired customer.
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When the PBX configuration work has been completed, which includes all Customer Onboarding work,
the CloudLink Gateway is automatically configured and there is no additional programming to do.
Note that all changes made to the MiVoice Office PBX are propagated immediately to the CloudLink
Platform.

Number of Mitel One users supported on MiVoice 400 PBX

The following table summarizes the maximum number of Mitel One users supported on the MiVoice
400 PBX.

Test
ing Envi
ronment

Mini
mum 
Rele
ases

MiVo
ice Offi
ce 400

CloudLink
Gateway

Maxi
mum 
Mitel
One Us
ers

Maximum Simultan
eous Call (Direct Sw
itching)

Maximum Simultan
eous Call (Indirect 
Switching)

SMBC -
Internal
CloudLink
Gateway

SMBC Embedded
in SMBC

50 • 25 Mitel One to
Mitel One

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

• 15 Mitel One to
Mitel One

• 15 Mitel One to
Internal

• 15 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Mitel
470 -
External
CloudLink
Gateway

6.3 or
later

Physical
Mitel
470

CloudLink
Gateway

300 • 25 Mitel One to
Mitel One

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

• 25 Mitel One to
Mitel One

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Virtual
Appliance
-
Virtualized
CloudLink
Gateway

Virtual
Appliance

OVA 300 Default appliance
with 1 core CPU
and 2GB RAM

• 25 Mitel One to
Mitel One

Default appliance
with 1 core CPU and
2GB RAM

• 25 Mitel One to
Mitel One
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Test
ing Envi
ronment

Mini
mum 
Rele
ases

MiVo
ice Offi
ce 400

CloudLink
Gateway

Maxi
mum 
Mitel
One Us
ers

Maximum Simultan
eous Call (Direct Sw
itching)

Maximum Simultan
eous Call (Indirect 
Switching)

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Large appliance
with 8 cores CPU
and 4GB RAM

• 125 Mitel One
to Mitel One

• 125 Mitel One
to Internal

• 125 Mitel One
to PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Note:
125
simultaneous
calls are
supported
only if the
appliance is
upgraded to
OVA version
1.1.3 or later.

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Large appliance
with 8 cores CPU
and 4GB RAM

• 125 Mitel One
to Mitel One

• 125 Mitel One
to Internal

• 125 Mitel One
to PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Note:
125
simultaneous
calls are
supported only
if the appliance
is upgraded to
OVA version
1.1.3 or later.
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Test
ing Envi
ronment

Mini
mum 
Rele
ases

MiVo
ice Offi
ce 400

CloudLink
Gateway

Maxi
mum 
Mitel
One Us
ers

Maximum Simultan
eous Call (Direct Sw
itching)

Maximum Simultan
eous Call (Indirect 
Switching)

MSL 7.0
HF2 or
later

Virtual
Appliance/
MSL

OVA/MSL 300 Default appliance
with 2 cores CPU
and 2GB RAM

• 25 Mitel One to
Mitel One

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Large appliance
with 8 cores CPU
and 5GB RAM

• 125 Mitel One
to Mitel One

• 125 Mitel One
to Internal

• 125 Mitel One
to PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel On to
Mitel One

Default appliance
with 2 cores CPU
and 2GB RAM

• 25 Mitel One to
Mitel One

• 50 Mitel One to
Internal

• 50 Mitel One to
PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Large appliance
with 8 cores CPU
and 5GB RAM

• 125 Mitel One
to Mitel One

• 125 Mitel One
to Internal

• 125 Mitel One
to PSTN

• 16 Mitel One to
Mitel One

• 12 Mitel One to
Mitel One

Note:
The maximum values mentioned in the table are subject to available bandwidth. For
information regarding the best practices recommended for CloudLink site deployments,
see Best Practices for Site Deployments.
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Documentation

Choose one of the following topics for the platform being used to configure your MiVoice Office 400
PBX (MiVO400) to integrate with CloudLink. For PBX documentation, click here.

5.1 Configure MiVO400 on Standalone Platform

This topic explains how to configure a MiVoice Office 400 PBX on an standalone platform (with
external Gateway) to integrate with CloudLink. For detailed PBX instructions, see the MiVO400
technical documentation.

Use the instructions in the sections below in this specific order to ensure that your MiVO400 is
correctly integrated with CloudLink. Leave all other settings (not specifically mentioned in these
sections) set to the default value.

1. Create CloudLink Application Credentials
2. Enable CSTA Service
3. Add CloudLink App Users
4. Configure SIP Multi Lines and Manage Call Permission on page 88
5. Enable CTI Service on page 89
6. Onboard Customers
7. Verify SIP Networking
8. Verify Mitel CloudLink Gateway Service
9. Configure GSM Call Through Feature

Create CloudLink Application Credentials

For licensing purposes, an admin user must be added to the MiVoice Office 400 PBX to create
CloudLink application credentials, which sets the CloudLink Gateway as a trusted application.
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1. Navigate to Configuration > System > Access Control > User account and click
the New button.

2. Create an admin user as indicated below.

• In the User name field, enter any username that is 25 characters or less.
• In the Password field, enter any valid password that is 255 characters or less.
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Note:

The username and password values entered here must also be entered in the
CloudLink System Username and CloudLink System Password fields in the
Configure PBX section of the CloudLink Gateway Portal during customer onboarding.
For more information, see MiVoice Office 400 PBX information.

• In the Password confirmation field, re-enter the same password.
• In the Authorization profile field, select the CloudLink access option.
• In the File access field, select the Read write option.

3. Click the Apply button to create this user. Verify that a green check mark appears in
the Active column next to new user.

Enable CSTA Service

The CSTA (computer-supported telecommunications applications) service needs to be enabled.

1. Navigate to Configuration > IP network > CSTA service.
2. Select the check box next to the CSTA service active field.
3. Leave the CSTA service port set to the default value of 7001. If needed, you can set

this to a different number.
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Note:
The service port number set here must also be set in the Port field in the
Configure PBX section of the CloudLink Gateway Portal during customer
onboarding. For more information, see MiVoice Office 400 PBX information.

Add CloudLink App Users

The MiVoice Office 400 PBX needs to be programmed to add all of the users who will be able to
access CloudLink applications like the Mitel One.

To create a user:

1. Navigate to Configuration > Users
2. Enter the following required information for each user of the Mitel One application:

• Name
• E-mail address
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3. Click Apply. Users will be propagated through push notifications to the CloudLink
Platform.

Note:
When users register their Mitel One application for the first time, the MiVoice Office
softphone terminal is created and assigned to those users on the MiVoice Office 400
PBX.

To log in to the Mitel One application, a user must have a valid:

• MiVoice 400 Software Assurance (SWA) license from Mitel
• MiVoice Office softphone terminal license in the MiVoice 400 PBX.

If the user does not have these two licenses or if these licenses have expired, a No License
Available alert appears when the user attempts to log in to the Mitel One application and the
user will not be able to log in. The user must then obtain new licenses or renew the existing
licenses to continue using the Mitel One application.

To edit the email address of a user:

1. Navigate to Configuration > Users.
2. Enter the new email of the user in the E-mail address field.
3. Click Apply to save the changes.
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4. Sync the MiVoice Office 400 PBX with the CloudLink Gateway for the changes to
reflect in the CloudLink Platform.

Configure SIP Multi Lines and Manage Call Permission

To enable call waiting in the Mitel One application, you must:

• configure the MiVO-400 SIP terminal representing the SIP softphone to set the Multi
lines value set to 3.

• in Permission Set:

• enable Call Waiting for the softphone
• disable Busy on busy for the softphone.

To configure these settings, proceed as follows:

1. Navigate to Configuration > Terminals > Standard Terminals.
2. Set the value to 3 in the Multi lines field under the Further settings section.

3. Click Apply to save the changes.
4. Navigate to Users > Permission Set.
5. Click the required permission set from the list. A panel opens.
6. Under Outgoing calls, select the check box beside Call waiting to enable it.
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7. Under Incoming calls, clear the check box beside Busy on busy to disable it.

8. Click Apply to save the changes.

Enable CTI Service

To control the call features on a user's deskphone using the Mitel One Web Application, you
must enable Computer Telephony Integration (CTI) service on the deskphone associated with the
user's Mitel CloudLink account. To enable this setting, the user must have a functioning MiVO400
deskphone and verified the extension number indicated in the Mitel CloudLink account.

To enable CTI service on the deskphone, proceed as follows:

1. Navigate to Configuration > Users > User list.
2. Select the user whose deskphone you need to configure. The User page opens.
3. In the Settings section, click the drop-down list associated with the Use for CTI option

and choose the deskphone associated with the user's Mitel CloudLink account.
4. Click Apply to save the changes.
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Onboard Customer

The next step of the integration process is to complete the Onboard Customers steps. When
onboarding is completed, updates to the MiVO400 are completed automatically. Return to this
page to continue with the next section below.

Verify SIP Networking

For SIP networking, a Local SIP node user is automatically created. To verify this, navigate
to Configuration > Private networking > SIP networking and ensure that a user name was
created under Local SIP node as shown below.

Verify Mitel CloudLink Gateway Service

To verify service, navigate to Configuration > Services > Mitel CloudLink Gateway and ensure
that the check box next to the Service enabled field is selected as shown below.
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Configure GSM Call Through Feature

The MiVoice Office 400 PBX needs to be configured as explained below to support the GSM Call
through feature for CloudLink applications.

1. Navigate to Configuration > Services > Mitel CloudLink Gateway.
2. Under the DDI (DID) number heading, select the used DDI (DID) plan and an unused

DDI in Call through number.
3. Under the Mitel Office client dial-in numbers heading, set the full dialable Call

through number.

Note:
The Call through number under the Mitel Office client dial-in numbers
heading must be configured in the E.164 format.

4. To verify the DDI (DID) number that was created above, navigate to Configuration >
Routing > Graphical view to confirm that the correct number appears under the DDI
(DID) plan heading shown below.
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5. If the GSM Call Through feature uses SIP trunk access, the Relay RTP data via
communication server (indirect switching) setting is disabled (not selected) by
default for the trunk interface. If incoming GSM calls cannot be received, it might be
due to a firewall configuration issue. Data addressed with the ports 65336-65534 /
udp (rtp) should be forwarded to the CloudLink Gateway IP address.Alternatively, RTP
relay must be enabled: navigate to Configuration > Routing > List View > Network
Interfaces, and in the NAT section of the interface, select the check box Relay RTP
data via communication server (indirect switching). Note that enabling RTP relay
requires more VoIP channels.

6. If your MiVoice Office 400 PBX is configured to use exchange access codes for
other Mitel applications, the Activate auto completion setting shown below must be
selected. To do this, navigate to Configuration > Routing > Exchange > General
and select the Activate auto completion check box in the Auto completion of
exchange access code... section.
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5.2 Configure MiVO400 on SMBC Platform

This topic explains how to configure a MiVoice Office 400 PBX on an SMBC platform (with
embedded Gateway) to integrate with CloudLink. For detailed PBX instructions, see the MiVO400
technical documentation.

Use the instructions in the sections below in this specific order to ensure that your MiVO400 is
correctly integrated with CloudLink. Leave all other settings (not specifically mentioned in these
sections) set to the default value.

1. Add CloudLink App Users
2. Install Mitel CloudLink Gateway Application
3. Access Application Configuration Link
4. Onboard Customers
5. Verify CloudLink SMBC
6. Verify CSTA Service
7. Verify SIP Networking
8. Verify Mitel CloudLink Gateway Service
9. Configure GSM Call Through Feature

Add CloudLink App Users

The MiVoice Office 400 PBX needs to be programmed to add all of the users who will be able to
access CloudLink applications like the Mitel One application.

To create a user:

1. Navigate to Configuration > Users
2. Enter the following required information for each user of the Mitel One application:

• Name
• E-mail address
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3. Click Apply. Users will be propagated through push notifications to the CloudLink
Platform.

Note:
When users register their Mitel One application for the first time, the MiVoice Office
softphone terminal is created and assigned to those users on the MiVoice Office 400
PBX.

To log in to the Mitel One application, a user must have a valid:

• MiVoice 400 Software Assurance (SWA) license from Mitel
• MiVoice Office softphone terminal license in the MiVoice 400 PBX.

If the user does not have these two licenses or if these licenses have expired, a No License
Available alert appears when the user attempts to log in to the Mitel One application and the
user will not be able to log in. The user must then obtain new licenses or renew the existing
licenses to continue using the Mitel One application.

To edit the email address of a user:
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1. Navigate to Configuration > Users.
2. Enter the new email of the user in the E-mail address field.
3. Click Apply to save the changes.
4. Sync the MiVO 400 PBX with the CloudLink Gateway for the changes to reflect in the

CloudLink Platform.

Install Mitel CloudLink Gateway Application

Install the Mitel CloudLink Gateway application software using the SMB Controller Manager
admin console. The MiVO400 technical documentation provides detailed instructions for installing
application files and configuring associated LED indicators in the SMB Controller Manager.

After this software is installed, you will see Mitel CloudLink Gateway (Application
configuration) listed under Currently Installed applications in the SMB Controller Manager.

Access Application Configuration Link

To properly complete the customer onboarding, the first time the CloudLink Gateway Portal is
accessed, it must be accessed from the SMB Controller Manager.

Navigate to Software > Applications and click the Application configuration link shown in the
image above. After customer onboarding is completed, the CloudLink Gateway Portal can be
accessed several different ways. For details, see Access the CloudLink Gateway.

Onboard Customer

The next step of the integration process is to complete the Onboard Customers steps. When
onboarding is completed, updates to the MiVO400 are completed automatically. Return to this
page to continue with the next section below.
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Verify CloudLink SMBC/VA Account

A user name is automatically created and configured as part of the Mitel CloudLink Gateway
application installation. To verify that a user name was set to CloudLink=Gateway=SMBC
(CloudLink=Gateway for VA platform) as shown below, navigate to Configuration > System >
Access control > User account.

Verify CSTA Service

The CSTA (computer-supported telecommunications applications) service is automatically
enabled and set to port 7001 by default. To verify this, navigate to Configuration > IP network
> CSTA service and ensure the check box is selected next to CSTA service active as shown
below.
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Verify SIP Networking

For SIP networking, a Local SIP node user is automatically created. To verify this, navigate
to Configuration > Private networking > SIP networking and ensure that a user name was
created under Local SIP node as shown below.

Verify Mitel CloudLink Gateway Service

To verify service, navigate to Configuration > Services > Mitel CloudLink Gateway and ensure
that the check box next to the Service enabled field is selected as shown below.

Configure GSM Call Through Feature

The MiVoice Office 400 PBX needs to be configured as explained below to support the GSM
"Call through" feature for your CloudLink applications.
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1. Navigate to Configuration > Services > Mitel CloudLink Gateway.
2. Under the DDI (DID) number heading, select the used DDI (DID) plan and an unused

DDI in Call through number.
3. Under the Mitel Office client dial-in numbers heading, set the full dialable Call

through number.

Note:
The Call through number under the Mitel Office client dial-in numbers
heading must be configured in the E.164 format.

4. To verify the DDI (DID) number that was created above, navigate to Configuration >
Routing > Graphical view to confirm that the correct number appears under the DDI
(DID) plan heading shown below.

5. The Relay RTP data via communication server (indirect switching) setting
is disabled by default (not selected). If this setting is enabled for any reason,
incoming GSM calls will not be received. To prevent or resolve this issue, navigate to
Configuration > Routing > List View > Network Interfaces and in the NAT section
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of the interface, ensure that the Relay RTP data via communication server (indirect
switching) check box is not selected.

6. To enable placing a call without adding the external prefix, you must select the
Activate auto completion option and enter the number of digits valid for your
configuration. To do this, navigate to Configuration > Routing > Exchange >
General and select the Activate auto completion check box in the Auto completion
of exchange access code... section.

5.3 Configure MiVO400 on Virtual Appliance

This topic explains how to configure a MiVoice Office 400 PBX on a Virtual Appliance (VA)
(VMware or Hyper-V) to integrate with CloudLink. For detailed PBX instructions see, MiVO400
technical documentation.
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Use the instructions in the sections below in this specific order to ensure that your MiVO400 is
correctly integrated with CloudLink. Leave all other settings (not specifically mentioned in these
sections) set to the default value.

1. Add CloudLink App Users on page 94
2. Install CloudLink Gateway Application on page 101
3. Configure CloudLink Gateway
4. Access Application Configuration Link on page 96
5. Onboard Customer on page 96
6. Verify CloudLink SMBC/VA Account on page 97
7. Verify CSTA Service on page 97
8. Verify SIP Networking on page 98
9. Verify Mitel CloudLink Gateway Service on page 98

10. Configure GSM Call Through Feature on page 98

Install CloudLink Gateway Application

Install the CloudLink Gateway application using MSL Server-Manager.

Note:
Ensure that the Virtual Machine has at least two CPU cores assigned.

1. Download the ISO file from MiAccess Portal under Software Download Center option.

2. Copy the ISO file to the storage of your hypervisor (VMware or HyperV).
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Note:
It is recommended that the Connect at power on settings is on. If the Connect
at power on is not on, the admin must mount the virtual CD/DVD drive in order to
display the ISO file in MSL Server-Manager.

3. Browse to MSL Server-Manager (https://<IP-Address>:8443).
4. Log in by entering admin as User name and admin-password as password.

The Mitel Standard Linux window is displayed.

5. Navigate to ServiceLink > Blades.

CloudLink Gateway is displayed in the table.
6. Click Install and accept the licence agreement.
7. Remove CD-ROM ISO-image.
8. Click Clear this report.

The CloudLink Gateway downloads the required components from the cloud in the
background.

Configure CloudLink Gateway

1. In the MSL Server-Manager, navigate to Applications > CloudLink Gateway.
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2. Click CloudLink portal.

You are redirected to the CloudLink portal.

For more information about onboarding customers see, Onboard Customers Using Navigation
Bar or a Single Page on page 60.
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• Environment
• Integration
• Deploying the CloudLink Gateway
• Troubleshooting

The following topics contains information about how to install, deploy, integrate, and govern call
processing behaviors for CloudLink solution with existing MiVoice Business solution.

6.1 Environment

In the Mitel CloudLink environment, the CloudLink Gateway enables the connection between a
MiVoice Business and the CloudLink Platform.

6.1.1 System Requirements

Licensing

There are no new MiVoice Business (MiVB) Licenses related to CloudLink Onboarding, nor
has the MiVB licensing model changed. Although CloudLink, MiVoice Business, and MiVoice
Border Gateway use SIP trunks for the integration, SIP Trunk licenses are not consumed for this
integration.

Partners must have Software Assurance (SWA) to have access to the CloudLink API program.
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6.1.1.1 CloudLink Solution Prerequisites

• MiVoice Business PBX Release 9.4 or later.
• MiVoice Border Gateway Release 11.4 or later
• MiCollab (not a prerequisite). However, if there is a requirement to have an MBG

cluster with the MBG/MSL containing the CloudLink Gateway, the MBG software
versions within MiCollab and on MBG servers must be the same software version (that
is, MBG Release 11.4 or later) as per existing engineering guidelines.

• CloudLink enablement requires current Software Assurance (SWA) and End User
licensing as indicated in the Licensing section.

Note:

Software Assurance is a requirement for CloudLink and CloudLink Applications. Expiring
Software Assurance may result in CloudLink features being denied. Please consult the
following link.

6.1.1.2 CloudLink Gateway Prerequisites

The following are the prerequisites for CloudLink Gateway:

• An Internet connection that provides enough bandwidth.
• A DHCP server to assign an IP address to the CloudLink Gateway. This is not

mandatory in virtual environments.
• A DNS server that the CloudLink Gateway uses to resolve domain names.
• An Ethernet connection to the LAN.
• Passwords to be entered during the MiVoice Business configuration.
• Mitel MiAccess account.
• Ports: You must ensure that the ports on MiVoice Business are reserved for

operational use for the CloudLink Gateway and that the connections are routed
properly through the corporate network. For more information, see Connections
Between the CloudLink GW and PBX/Call Server > MiVoice Business Considerations.

6.2 Integration

The following example shows MBG and CloudLink Gateway on a Virtual Machine with MSL.
Azure will incorporate the MSL, MBG, CLGW and MiVB on a Virtual Machine but otherwise the
description/information is consistent.
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Figure 1: MiVoice Business with CloudLink Integration

MiVoice Business with CloudLink Integration is an attempt to simplify the architecture of this
solution in a way that MiVoice Business Partners and customers can understand.

The CloudLink Solution is divided into four primary components:

• The PBX (for example; MiVoice Business)
• A Virtual Machine with CloudLink Gateway and MiVoice Border Gateway

• CloudLink Gateway and MiVoice Border Gateway are both blades available for
installation from Mitel Standard Linux.

• Virtual Machine with VMware or Azure is supported.
• CloudLink Platform
• CloudLink Applications (Mitel or developed by third-party

For the CloudLink Platform to fully interwork with Mitel PBXs (that is, MiVoice Business), it
requires Mitel's Border Gateway and the Mitel's CloudLink Gateway. The MiVoice Border
Gateway and CloudLink Gateway are both deployed on the same Virtual Machine.

In Figure 1: MiVoice Business with CloudLink Integration on page 106, you will find arrows
indicating interface connections. The following will explain each interface:

6.2.1 Interface 1 (Between CloudLink Application and
CloudLink Platform)

The CloudLink Platform provides Third-Party Developers with APIs to develop their own
CloudLink applications. CloudLink provides APIs to help develop Telephony, Messaging and
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Administrative applications to interwork with MiVoice Business solution. More details can be
found on Mitel’s Developer Portal.

Note:
It is possible that Mitel will provide an application using the same APIs. An example is
Mitel One for the MiVoice Office 400.

6.2.2 Interface 2 (Between CloudLink Platform and
CloudLink Gateway)

The CloudLink Platform interworks with the CloudLink Gateway to use the Telephony, CTI and
Database APIs provided by the MiVoice Business. The main role of the CloudLink Gateway is to
provide a common and standardized set of APIs to the CloudLink Platform so that the CloudLink
Platform requires minimal knowledge of the intricacies of the Mitel PBXs it supports.

6.2.3 Interface 3 (Between MiVoice Border Gateway and
CloudLink Platform)

The CloudLink Platforms interworks with the MiVoice Border Gateway to provide SIP Trunking for
CloudLink applications (not currently used in Mitel CloudLink APIs). In the CloudLink or MiVoice
Business solution, the MiVoice Border Gateway supports all of its current functionality in addition
to supporting the CloudLink Platform and CloudLink Gateway.

6.2.4 Interface 4 (Between CloudLink Gateway and
MiVoice Border Gateway)

The MiVoice Border Gateway provides APIs to the CloudLink Gateway to allow CloudLink to
automatically provision the MiVoice Border Gateway during the configuration process (CloudLink
Gateway Configuration on page 114), which includes the configuration of SIP Trunking.

Note:

MiVoice Border Gateway is typically used for Softphone functionality. CloudLink applications
that do not include Softphone/Telephony services might not require MiVoice Border Gateway.
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6.2.5 Interface 5 (Between CloudLink Gateway and
MiVoice Business)

The CloudLink Gateway accesses existing CTI and Database interfaces on the MiVoice
Business. From the MiVoice Business perspective, the CloudLink Gateway just looks like any
other application that uses similar interfaces, such as MiCollab or OIG. Similar to Interface 4,
the MiVoice Business is automatically configured to work with the CloudLink solution once the
solution is deployed and the customer is CloudLink onboarded.

6.2.6 Interface 6 (Between MiVoice Business and MiVoice
Border Gateway)

As mentioned earlier, the MiVoice Border Gateway and MiVoice Business interwork to support
SIP Trunking integration with CloudLink.

6.3 Deploying the CloudLink Gateway

For additional information about the topics in this chapter, refer to the CloudLink Gateway User
Guide (mitel.com) on the Mitel website.

To configure the CloudlLink telephones

1. Integrate MitelOne with the ClouldLink Customer account. See the section Mitel
One Integration in CloudLink Accounts Console User Guide (mitel.com) for more
information.

2. Integrate CloudLink Gateway with the ClouldLink Customer account. See the section
Integrating CloudLink Gateway with CloudLink Accounts in CloudLink Accounts
Console User Guide (mitel.com) for more information.

3. Send welcome emails to the users in the customer account. See the section Managing
Users in CloudLink Accounts Console User Guide (mitel.com) for more information.

4. Enable the MiNet Teleworker Devices in the MiVoice Border Gateway server manager
application and connect the device to the primary configured ICP. See the section
Add or Edit MiNet Devices in the MiVoice Border Gateway Online Help for more
information.

Deployment strategy

CloudLink will be integrated with both new and existing customers. The following strategy
outlines and simplifies the deployment scenarios:

1. The CloudLink solution will not be integrated until the customer has fully deployed the rest of
their MiVB solution, which might include MiCollab. “Fully deployed” infers that the site is fully
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licensed (MiVB, MBG, and MiCollab (if applicable)) and users are configured with functioning
phones. This gives CloudLink a deterministic solution in which to integrate.

Note:
For existing customer sites with MiCollab, MiCollab might already be integrated
with CloudLink. For the same Customer Account on CloudLink, you must integrate
MiVoice Business with CloudLink Gateway.

2. If a customer already has an MBG in the solution through MiCollab or standalone, there will be
no attempt to integrate it with the MBG packaged with CloudLink Gateway. The existing MBG
will continue to support the solution as it already does (that is, Teleworker) and a new MBG
with CloudLink Gateway will be used for CloudLink-specific activities related to the CloudLink
SIP Trunk.

3. CloudLink is solely responsible for the provisioning and management of CloudLink services.
All other solution provisioning and management is done in the same manner as with any other
MiVoice Business Solution. More specifically, MiCollab would continue to manage the user as
a whole and all their other non-CloudLink devices.

Installing Virtual Machine CloudLink Gateway

The CloudLink Gateway software will be available as a blade on MSL when MiVoice Border
Gateway (MBG Release 11.4 or later) is installed.

Note:
The Partner/Customer can choose whether or not the CloudLink Gateway will be
installed.

6.3.1 VMWare Requirements

The Virtual CloudLink Gateway Appliance is supported in the following VMware environments
(the requirements being the same as for MiVoice Border Gateway).

• ESXi 6.5 or later

6.3.2 Azure Requirements

For the Azure requirements, see the MiVoice Business Solution Azure Deployment Guide.
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6.3.3 System Requirements

Refer to the MiVoice Border Gateway release 11.4 or later version Engineering Guideline
documentation for the latest VMware, Azure and CloudLink Gateway guidelines - including
CloudLink Gateway resource impacts bandwidth requirements and system size - as well as
impacts to MiVoice Border Gateway usability.

6.3.4 Integrating CloudLink Gateway - Overview

As a CloudLink Administrator you will be required to create a CloudLink (Customer) account in
the accounts console. After you create the CloudLink Account, you can begin the deployment of
the CloudLink Gateway to associate the gateway with the Customer Account.

Note:
For initial onboarding of CloudLink Gateway connections to the CloudLink Platform,
Administrators of the CloudLink Gateway on MSL must use the CloudLink Portal
button to connect with the CloudLink Platform to complete CloudLink Gateway
Integrations.

During CloudLink Gateway integration, the PBX will be synchronized with CloudLink to import
PBX users and to have some parameters on MiVoice Business and MiVoice Border Gateway
automatically configured.

Note:
For existing customer sites with MiCollab, MiCollab might already be integrated with
CloudLink. Note that for the same Customer Account on CloudLink, the CloudLink
Gateway to the MiVoice Business will still need to be integrated. This is discussed in
the next module.

CloudLink applications can be enabled for users, but details of this are not covered in this
document.

This document provides the initial steps required to configure the CloudLink Gateway. The
supported type of CloudLink Gateway Appliances in Phase 1 is Virtual CloudLink Gateway
(VMware and Azure).
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6.3.5 Applying Subscription Licenses to an Account

CloudLink applications generally require subscription licenses. When license bundles are
purchased and applied against a Partner Account, the Partner Administrator must apply the
licenses to a specific Customer Account in the CloudLink Accounts Console.

CloudLink subscription licenses do not use Mitel's AMC or SLS licensing server. CloudLink
subscription licenses as part of an overall License profile are ordered using CPQ and appear
automatically under the Partner Account on CloudLink.

This section provides a high-level description of how to view, search for and assign Orders to a
Customer (Account). Note that CloudLink Accounts Console is continuing to evolve.

The following link will provide an up-to-date description of Billing and Orders:

https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/cloudlink-accounts-
html

Prerequisite

• CloudLink Account Console Administrator user name and password
• Access privileges to any account you plan to view or assign licenses to.

Steps to View and Assign Subscription Licenses

1. Log in to the CloudLink Account Console as the Partner Administrator.
2. On the left side of the Accounts page, next to Billing select Down arrow and select

Orders to view all CloudLink subscriptions purchased by the Mitel Partner along with
details.

Note:

When the Partner purchases licenses through CPQ, the subscription license are
automatically listed in the Orders page for the Partner.
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3. To assign an oder, click the ASSIGN button.

4. The Administrator can:

a. Identify how many CloudLink Application Licenses will be provided based on the
Subscription Number.

b. Select the Company drop-down list to apply the Licenses.

OR

a. If the required Customer Account does not exist, select Create New Account.
CloudLink will move you to the Accounts section where you can create an Account.

5. Select the Assign button.

After the license has been assigned to the Customer Account, the Partner Administrator (or an
Account Administrator belonging to that particular Customer Account) can add and configure (if
necessary) the corresponding integration.

6.3.5.1 CloudLink Gateway Integration

To enable the CloudLink Gateway for a Customer Account, a user must log in to the CloudLink
Accounts Console as explained earlier.

The following procedure will take the Administrator through the steps to enable the CloudLink
Gateway for a Customer Account. It is assumed that the Administrator has already logged in to
the CloudLink Accounts console.

1. Log in to the CloudLink Account Console as the Partner Administrator.
2. On the left side of the Accounts Console Dashboard page, click Accounts to view

all the CloudLink customer accounts.
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3. Select an account from the customer Accounts list.

The Account Information page opens.
4. In the Account Information page, select Integrations.

A pop-up screen displays the Integrations panel.

5. Click +Add New.
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6. From the Mitel tab, click the Add button associated with CloudLink Gateway and
click Done.

CloudLink Gateway is now integrated for the customer account and listed in the Integrations
window.

For further information about the status message that appears beneath CloudLink Gateway, see
CloudLink Gateway Status.

6.3.5.1.1 Onboarding the CloudLink Gateway

After enabling the CloudLink Gateway integration in the CloudLink Accounts console, you must
associate the gateway to the Customer Account, configure the gateway and sync a PBX to pull
in PBX Users into CloudLink. For more information, see https://productdocuments.mitel.com/
AEM/Technology/CloudLink/All%20Releases/CloudLink%20Gateway/EN/HTML5/
index.html#t=Content/Onboard_Customers.html.

6.3.5.1.2 Advanced Settings and Options

Configure the Advanced Screen as required. For more information, see Configure Advanced
Settings and Options.

6.3.5.2 CloudLink Gateway Configuration

After integrating the CloudLink Gateway with the CloudLink Accounts console, you must
configure the gateway and sync a PBX to pull in PBX users into the CloudLink Customer
account.
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1. In the Account Information page, select Integrations.

A pop-up screen displays the Integrations panel.
2. Click Add Gateway. The Gateway page will open.

3. In the Gateway Information section of the Gateway page, provide the following
details:

• Site Name
• Complete address for the physical location of the PBX

4. Click Next.
5. In the Configure PBX section, provide the following details:

a. PBX Type: MiVoice Business

Note:

When MiVoice Business is entered as the PBX, the display will change to include
MiVoice Border Gateway settings.

b. PBX Name: enter a name for the PBX
c. IP Address: enter the IP Address or FQDN for the PBX
d. MBG IP Address or FQDN: Enter the appropriate IP address or FQDN for the

MBG
e. MBG Password: Enter the admin password for MBG.
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Note:
Currently, the password can contain a maximum of 15 characters.

Click Next.

The accounts console will try to establish a connection with the CloudLink Gateway at the
customer site. When a successful connection is established with the PBX, a pop-up message
will be displayed indicating: Successfully created PBX link.

6. Click Sync to synchronize PBX users with the CloudLink Account.

A successful synchronization will result with the following display:

Note:

Do not click Sync Now after you have just connected with the PBX. A synchronization will
have automatically started or may be in progress. To verify this, you can observe whether
the user count is increasing for the Customer Account. A synchronization is required only
if changes have been made on the PBX.

By default, synchronization occurs every 20 minutes.

7. Click Next.
8. (Optional ) You can use the Deployment page if you want to deploy the CloudLink

Application associated with your PBX by sending deployment emails to the imported
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users so that they can register their account and receive introductory information
about the application.

Sending deployment emails can be done any time from the Users page in the CloudLink
Accounts Console. To navigate to the Users page, select the Select the check box to go to
the Users List page after you press the Complete button check box and click Complete.

The Users page displays with a list of users that were added to the CloudLink Account.

The Cloudlink Gateway is successfully configured.

The Account Information page now displays the PBX type:
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The status message under Integrations in the Account Information page will show Onboarding
Complete for CloudLink Gateway.

Customer Account ID has been added to the Mitel Standard Linux CloudLink Gateway page.

6.4 Troubleshooting

Troubleshooting CloudLink

This section describes how to troubleshoot CloudLink.
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Table 1: Troubleshooting CloudLink issues

Problem Solution

The browser displays Lost Connection to
Gateway and Retry does not work.

Clear the browser cache or open a new
Browser Tab or Window.

Browser displays Failed to Connect to mitel.io. Check Firewall Settings for outgoing https
access to *.mitel.io

• No DNS Server servicing the subnet
• DHCP Server failed to provide DNS

Service
• Outgoing port blocked by firewall.

Check Firewall Settings for outgoing
https access to *.mitel.io

CloudLink Gateway needs to be replaced When the connection fails, there is a link to
configure a new CloudLink Gateway
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• Environment
• Installing the CloudLink Gateway Certificate into MiVoice MX-ONE Provisioning Manager
• MX-ONE System Setup
• MX-ONE Provisioning Manager – CloudLink Tasks

The following topics contains information about how to install, deploy, integrate, and govern call
processing behaviors for CloudLink solution with existing MiVoice MX-ONE solution.

7.1 Environment

In the Mitel CloudLink environment, the CloudLink Gateway enables the connection between
MiVoice MX-ONE and the CloudLink Platform.

The following figure shows the CloudLink overall solution, where the MiVO PBX represents MX-
ONE.

The solution between MX-ONE and CloudLink has the following key system functions:

• API – Application Programming Interface

• API defines the way that the systems will interact with each other.
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• CSTA – Computer Supported Telecommunications Applications

• It provides third-party call control. It is an interface that external computer
applications can use to remotely control a phone.

• SIP – Session Initiation Protocol and Media Handling

• SIP extension is used to provide a valid PBX extension to a softclient.
• Media Handling provides media capability to the CloudLink solution.

7.1.1 Integration

The following figure illustrates the high-level solution overview of the integration between MiVoice
MX-ONE and CloudLink.

7.1.1.1 API – Application Programming Interface

CloudLink provides APIs that can be used to interact with CloudLink Services.

The CloudLink ecosystem has different APIs for different CloudLink components, such as
different CloudLink APIs for Authentication, Admin, Billing, and so on. The CloudLink Gateway
also contains an API that is used to add, change, delete and view users, SIP extensions
(softclients), and the SIP trunk in CloudLink Gateway.

The MX-ONE Provisioning Manager uses CloudLink APIs to add, change, delete and view
information in CloudLink.
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Depending on the service used in the solution, the Provisioning Manager will use one or more
APIs to perform each task. The API calls are implemented in the Provisioning Manager software
and it is transparent for the system administrator.

7.1.1.2 CSTA – Computer Supported
Telecommunications Applications

CloudLink Gateway contains a CSTA server that is used to interact with the different Mitel Call
Managers. CSTA III XML is used with MX-ONE.

The CSTA component in CloudLink Gateway supports the following:

• Monitoring: StartMonitor, StopMonitor, SnapshotDevice.
• Call control: MakeCall, ClearCall, ConsultationCall, AlternateCall, TransferCall,

ConferenceCall, SingleStepTransfer, HoldCall, RetrieveCall.
• Call events: service initiated, delivered, established, held, retrieved, diverted,

transferred, conferenced.
• Other functions: DND, MWI, Call Forward, Presence.
• Support for forking (multiple Terminals with same DN).

7.1.1.3 SIP – Session Initiation Protocol and Media
Handling

CloudLink Gateway contains a SIP PBX used to interact with the different Mitel Call Managers.

The SIP PBX component on the CloudLink Gateway LAN side supports the following:

• SIP TCP, SIP UDP
• RTP and SRTP (media)

7.1.2 System Requirements

The solution between MiVoice MX-ONE and CloudLink requires licenses, access to services, and
applications. The following sections list the minimum requirements for the basic solution.
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7.1.2.1 MX-ONE Requirements

• MX-ONE Licenses

• SIP extensions
• SIP trunk (optional)
• CSTA
• Provisioning Manager

• SWA License: An active SWA license subscription is required to have access to
configure CloudLink in MX-ONE. The PM/SNM can read the SWA status by typing the
license_status command.

Note:
SWA license is time-limited and has an expiry date. An alarm is sent 30 days
before the expiry date and the SWA subscription must be renewed before the
expiry date.

7.1.2.2 CloudLink Requirements

• Partner ID – the Mitel partner needs to have access to CloudLink Services via Mitel
MiAccess to be able to set up the solution.

• Admin account to be used by Provisioning Manager.
• CloudLink licenses for the specific services, such as MiTeam Meetings licenses.

7.2 Installing the CloudLink Gateway Certificate into
MiVoice MX-ONE Provisioning Manager

The CloudLink Server/ CloudLink Gateway communicates via an API with Provisioning Manager.
For this, the CLGW certificate has to be installed on PM server.

Also, it is mandatory to install the certificate before setting up CL/CLGW subsystem from the PM
interface.

The following procedure explains the process to establish the certificate using the
webserver_config (or mxone_maintenance) tool on the command prompt.

To configure the certificate to allow PM to trust CloudLink perform the following tasks:

1. Open up an SSH connection (using Putty or a similar app) to the PM server.
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2. Login using a suitable username and password (such as mxone_admin) and launch the
webserver configuration tool using the command sudo -H webserver_config.

3. Navigate to the Root Certificate Management option.

4. Choose the option Download Server Certificate by connecting to trusted host.
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5. Enter the IP address of the CloudLink Gateway, the remote server port (8086 by default) and a
descriptive text string as the certificate alias.

MX-ONE will attempt to connect to CLGW and download the certificate. After successful
connection, a command-line based message is displayed asking to trust the certificate. Type
Yes and then press enter to close the dialog.

6. After the certificate has been installed, restart jboss service.
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7.3 MX-ONE System Setup

7.3.1 Configure CloudLink Gateway Network Trunk via
Provisioning Manager

This is performed via Provisioning Manager under the Services menu.

1. Choose the CloudLink Gateway Network Trunks option and click Add.
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2. The wizard then asks for the following information:

• IP/FQDN of the CloudLink Gateway
• SIP Port Number (5060 or 5061 depending on protocol)
• Transport Protocol, TCP is the default used by CloudLink Gateway
• Description
• PBX user name, an MX-ONE user account used to authenticate SIP messages
• PBX user password, password for the user above
• Cloudlink Gateway user name, this defaults to officelinkmxone
• Cloudlink Gateway user password, password for the user above
• GSM Callthough Deploy Number, this allows mobile calls via the PBX to be routed

through the CloudLink Gateway.

7.3.2 Configure CloudLink Gateway SIP Route via Service
Node Manager

A new SIP Trunk profile has been added to MX-ONE 7.4 SP2 onwards, called CloudLink
Gateway. This allows a SIP connection to be established for media resources between the MX-
ONE and CloudLink. A SIP trunk only needs to be configured between MXONE and CloudLink
Gateway in case there exists an application in CloudLink requiring this type of connection.

To setup the SIP route, use the following process:
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1. The CloudLink Gateway profile requires the following information:

• CloudLink Authentication username
• CloudLink Authentication username password
• Remote Proxy IP of CloudLink Gateway

2. Launch Service Node Manager via its subsystem in Provisioning Manager.
3. Go to the Telephony / External Lines / Route option and choose Add.
4. Set the signaling type to SIP and choose the CloudLink Gateway profile.

5. Chose a suitable Route name and select an available route number.
6. Equip the route with trunk individuals for the server that connects to the CloudLink

Gateway, i.e., Server 1 1-10. This would allocate 10 SIP channels to the route.
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7. Enter the specific CloudLink Gateway information mentioned in step 1 and click apply.

8. As is shown on the image above, after the SIP route has been created a Destination may also
need to be created to direct calls to be able to reach the GSM CallThrough Number (if defined
in the next step).

7.3.3 Access the CloudLink Portal via Provisioning
Manager Subsystem

Once the CloudLink Gateway subsystem has been created in Provisioning Manager, it can be
used as another way of accessing the CloudLink Portal.

Clicking on the subsystem hyperlink opens a new browser window with the connection to the
portal.
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7.3.4 Service Node Manager

7.3.4.1 Configuring the MiVoice MX-ONE CSTA
Server

The MiVoice MX-ONE and CloudLink use the CSTA (Computer Supported Telecommunications
Application) protocol for all call control / CTI signaling between the two products via the
CloudLink Gateway.

As with many other integrations, MX-ONE must have the CSTA Server function enabled to allow
the CloudLink Gateway to connect via the protocol.

This is activated on MX-ONE via the Service Node Manager tool, accessed via Provisioning
Manager via the MX-ONE subsystem.
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1. In the Services/CSTA Server menu, choose the CSTA Server option on the left.

2. Click the Add button.
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3. Choose the MX-ONE Server (LIM) that will communicate with the CoudLink Gateway. The
options shown in the following image are the default:

If the CSTA server is already being used on MX-ONE to communicate with a different additional
platform (such as MiContact Center Enterprise) using the same CSTA settings required for
CloudLink Gateway but a different port number, then that port number should be used.

The port number chosen in Service Node Manager is then specified during the CloudLink
Gateway configuration via the Portal.

7.4 MX-ONE Provisioning Manager – CloudLink Tasks

Provisioning Manager is the tool to onboard users in CloudLink.

There are two ways of onboarding users in CloudLink:

• Provisioning Manager User Task

One by one, users are defined and added in CloudLink Platform and CloudLink Gateway.
• Bulk function via Provisioning Manager export (available in Further Release)

User already defined in Provisioning Manager are exported in excel format to be imported in
CloudLink Portal.
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7.4.1 Provisioning Manager User Task

To configure a user, do the following:

1. Navigate to Users > User and type asterisk(*) in the Enter User Name(s), Extension
Number, Department field.

2. Click View to view the list of users.
3. Click the Change button beside the user whose details you want to configure.

4. In the page that opens, click the CloudLink Configuration tab and do the following:

a. Select a CloudLink Extension from the Assign CloudLink Extension (Extension,
LIM IP) drop-down list.

b. Select a Cloudlink Server from the CloudLink Server drop-down list.
c. Select a role for the user from the CloudLink Role drop-down list.

5. Click Apply to complete the configuration for the user. With this, a user is
synchronized with the CloudLink account. Follow the steps 3-5 for configuring each
user.
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You can navigate to CloudLink Gateway portal > Deployment and check if the user is added
there.

You can navigate to CloudLink portal > User Management > Users and check if the user is
added there.

7.4.2 Bulk Function via Provisioning Manager Export

To use the bulk function via the Provisioning Manager Export option, navigate to System > Data
Management > Export task and select Export Data. Click Users With Extensions, select the
columns FIRST NAME, LAST NAME, EMAIL , and ROLE and then click Apply.

Provisioning Manager will generate an excel file in a zip format.

The Name column is generated by Provisioning Manager. The Role Column contain two roles,
user and admin and it needs to be manually selected by the system administrator before the file
is imported in the CloudLink Portal.

The Subsystem Name column is generated by Provisioning Manager to differentiate users in
different MX-ONE Systems. This column needs to be deleted before the file is imported in the
CloudLink Portal.
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7.4.3 Sync Option for CL/CLGW Subsystem

The Refresh/Synchronize option is available for CloudLink Subsystem.

This option is used to synchronize the CloudLink users from PM user database to CloudLink
Server. The CloudLink users present in PM will only be synchronized using this option.



Configure a MiVoice Office 5000 PBX 8

To access the CloudLink - Deployment Guide with MiVoice 5000 guide, click https://www.mitel.com/
document-center/technology/cloudlink/all-releases/en/cloudlink-deployment-guide-with-mivoice-5000.
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• Edit a Customer
• Deactivate an Existing Customer

The topics listed below provide instructions for managing your CloudLink customers.

9.1 Edit a Customer

To keep your customers' accounts updated and accurate, you can edit their information and
settings as needed.

To edit a customer:

1. Log into the CloudLink Gateway Portal.
2. In the Partner Dashboard that opens, review the status messages in the customer list,

which indicate what steps are required (if any) for each existing customer.
3. Click anywhere in the row of an existing customer to access that customer's account

settings.
4. Make the required changes.
5. Click Save.

9.2 Deactivate an Existing Customer

To deactivate an existing customer:

1. Click the X at the far right of the customer in the Partner Dashboard.
2. To confirm that you want to deactivate the customer, type the word “deactivate” in the

text box that appears.
3. Click Deactivate.
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You can modify or delete an existing customer from the Partner Dashboard, which is the home
page of the CloudLink Gateway Portal.

Customers who have already been deactivated are not displayed in the Partner Dashboard.

Reactivate a Deactivated Customer

To reactivate a previously deactivated customer, contact Mitel Partner Technical Support via a
login at https://www.mitel.com/en-ca/login.

https://www.mitel.com/en-ca/login


Customer Accounts and Account
Admin 10

Customer Accounts

In CloudLink, a customer account is where the users for that account are added. All users in a specific
customer account may interact with each other using a CloudLink application. For example, users who
work for XYZ Company can use the Mitel One application to place and receive calls and chats to other
users who also work for XYZ Company.

Account Admin

Administrative permissions can be enabled for an existing or a new user by sliding the toggle button
to the right associated with Account Admin. The following images displays the Account Admin
permission for:

• New user:
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• Existing user:

When one of these users registers their account, they will receive advanced CloudLink applications
permissions, which are not available to regular end users.

Note:
When you slide the toggle button associated with Account Admin  to the left, the user
only loses their advanced permissions (the user is not deleted from the account).
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Use the following table to troubleshoot issues and resolve problems you may encounter with the
CloudLink Gateway and CloudLink Gateway Portal.

Note:
A standalone platform with an external Gateway appliance requires a DHCP server on the
LAN. If a DHCP server is not running, the Gateway appliance will be unable to obtain an
IP address and will not function correctly.

Accessing the Gateway Appliance

Message (Issue) Possible reason Try this

Update Error on an SMBC
platform

(Problem with downloading
an update to an embedded
Gateway)

The Gateway might not be
able to connect to https://
download.mitel.io/.

An Administrator can apply
the "Restart" command to the
Mitel-CloudLink Gateway in
the Software > Applications
screen of the SMB Controller
Manager admin console.

No DHCP server or DHCP
server failed to allocate an IP
address.

Log in to the domain DHCP
server and try to locate the
CloudLink Gateway.

Did not use the http:// prefix Connect using an "http://"
prefixed IP address (for
example, http://192.168.0.1)

Bonjour service not installed or
working.

Uninstall and then reinstall
Bonjour Print Services.

Unable to connect to CloudLink
Gateway ( http://cloudlink.local/
does not resolve)

Unsupported browser Use a supported browser
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Message (Issue) Possible reason Try this

Access Denied

(You are not allowed to access
this page on the Mitel MiAccess
site)

The CloudLink 'policy' has not
yet been assigned to you.

Contact the Mitel MiAccess
Administrator in your
organization to request this
access.

Update Error on a standalone
platform

(Problem with downloading an
update to an external Gateway)

The Gateway might not be
able to connect to https://
download.mitel.io/.

The Gateway may not
be able to resolve https://
download.mitel.io/.

Check firewall settings to see
if outgoing 'https' access to 
https://download.mitel.io/ is
permitted.

Check DHCP configuration to
check whether there is a DNS
server provided to the Gateway.

Ping download.mitel.io from
a machine connected to the
same LAN subnet as the
Gateway.

The Gateway Appliance
Software Update on page
39 topic provides more
information.

Lost Connection to Gateway

(The connection to the
Gateway appliance is not
working)

Your browser is not able to
communicate with the gateway.

Generally, this is a temporary
condition encountered when
key services are not running
inside the Gateway.

If this condition persists for an
unusual length of time (more
than 15 minutes) then reset
the Gateway by pressing the
Recessed button.

The update operation did not
succeed

(There was a problem with
downloading an update to the
Gateway)

Power outage Ensure that the MiVoice 400
and the Gateway are always
connected to a UPS.
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Message (Issue) Possible reason Try this

Update Error Tunnel
(id .region.ngrok.io) is not
working

Gateway tunnel unable to
connect.

Ensure that the following are
open/allowed at the firewall:

• *.ngrok.com
• *.ngrok.io

Update Error (network not
reachable)

DNS or firewall issue Ensure that the customer
network including Firewall/
Gateway network is configured
properly.

Get

"https://download.mitel.io/
compat.yaml?
timestamp=1676355747592924443":
dial tcp: lookup
download.mitel.io on <dns-
sever-ip>:53: read udp
<gateway-ip>:<src-port> -
><dns-sever-ip>:53: read:
connection refused

Get

"https://download.mitel.io/
compat.yaml?
timestamp=1676357072469896898":
dial tcp: lookup
download.mitel.io on <dns-
server-ip>:53: read udp
<gateway-ip>:<src-port>-
><dns-server-ip>:53: i/o
timeout

The DNS server might
be blocked by firewall or
configured DNS server is
incorrect.

Ensure that the DNS Server
configuration on the Gateway
and firewall is configuration is
correct.

Get "https://download.mitel.io/
compat.yaml?
timestamp=1676356165676153908":

download.mitel.io might be blocked by
firewall. Ensure that the gateway has

access to download.mitel.io.
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Message (Issue) Possible reason Try this

dial tcp <ip-address>:443:
connect: connection refused

No Internet connectivity: host
not reachable: mitel.io:443:
dial tcp <ip-address>:443: i/o
timeout

Tunnel (https://
bf03895a8b332394859183a3849572bca389a.ngrok.io)
is not working

The gateway might not have
access to ngrok.io.

Check firewall configuration.

CLGW_ALARM_CRITICAL_PHASE_FAILEDPower interruption when
software update was in
progress.

Power cycle the gateway. The
system will attempt to reset to
factory default and start the
update process again.

Accessing the CloudLink Gateway Portal

Message (Issue) Possible reason Try this

Invalid email address When configuring admin contacts
or support contacts, or sending
Welcome emails, you are unable to
validate email addresses.

The CloudLink Platform
validates a user's email
address before accepting
it. In general, role-based
email addresses (for example
admin@, help@, support@,
info@, and so on.) are not
accepted by the CloudLink
Platform and are flagged as
invalid. Also, an email address
is flagged invalid if the email
server is not reachable. If you
think the email address you
provided is being incorrectly
flagged invalid, contact
your Administrator or Mitel
Technical Support.

For more information about downloading gateway logs see, Gateway.

If you need further assistance, contact Mitel Partner Technical Support via a login at https://
www.mitel.com/en-ca/login.
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